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PREFACE

About This Guide

This guide is intended for technical staff who are responsible for installing Oracle Knowledge. It provides 
detailed information on installing Oracle Knowledge product components and post-installation.

The preface contains the following information:

• In This Guide

• Examples of Product Screens and Text

• Operating System Variations in Examples and Procedures

• References to Web Content

In This Guide
This book, Installing and Configuring Oracle Knowledge, is divided into the following chapters:

Examples of Product Screens and Text
The product screens, screen text, and file contents depicted in the documentation are examples. We attempt to 
convey the product's appearance and functionality as accurately as possible; however, the actual product 
contents and displays may differ from the published examples.

Chapter Description

Chapter 1, Oracle Knowledge Overview Describes the general installation process, and lists hardware and 
software requirements.

Chapter 2, Planning to Install Oracle 
Knowledge

Describes the requirements that must be met before installing Oracle 
Knowledge products.

Chapter 3, Preparing to Install Oracle 
Knowledge Using WebLogic

Describes preparation measures, such as WebLogic server installation, 
that must be done prior to installation.

 Chapter 4, Installing Oracle Knowledge 
Intelligent Search

Describes using the automated installer to install and configure Oracle 
Knowledge Intelligent Search components.

 Chapter 5, Installing Oracle Knowledge 
Information Manager

Describes using the automated installer to install and configure Oracle 
Knowledge Information Manager components.

Chapter 6, Installing Oracle Knowledge 
Analytics

Describes using the automated installer to install and configure Oracle 
Knowledge Analytics components.

Chapter 7, Installing AnswerFlow Describes using the automated installer to install and configure Oracle 
Knowledge AnswerFlow components.

Chapter 8, Installing RightNow 
Integration Components

Describes using the automated installer to install and configure Oracle 
RightNow integration components.

Chapter 9, Troubleshooting Oracle 
Knowledge Installations

Describes how to resolve some common issue that might arise when 
installing and configuring Oracle Knowledge components.
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11   OPERATING SYSTEM VARIATIONS IN EXAMPLES AND PROCEDURES
Operating System Variations in Examples and Procedures
We generally use Linux screen displays and naming conventions in our examples and procedures. We include 
other operating system-specific procedures or steps as noted in section headings, or within topics, as 
appropriate.

We present command syntax, program output, and screen displays:

• in Linux format first

• in other Unix-specific variants only when necessary for proper operation or to clarify functional 
differences

• in Windows format only when necessary for clarity

References to Web Content
For your convenience, this guide refers to Uniform Resource Locators (URLs) for resources published on the 
World Wide Web, when appropriate. We attempt to provide accurate information; however, these resources 
are controlled by their respective owners and are therefore subject to change at any time.
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CHAPTER 1

Oracle Knowledge Overview

This chapter provides an overview of the Oracle Knowledge components for which this guide provides 
installation and configuration instructions. These components are:

Installation Process Overview
Perform post installation configuration and validation steps. The installers help you get all of the Oracle 
Knowledge components installed correctly. Depending on your configuration needs for a particular environment 
there must be some post installation configuration work in order for the environment to work together properly. 
This typically involves setting up load balancers, firewalls, and external web servers to server static content. 
Integrating into existing security mechanisms is out of the scope of this manual.

Oracle Knowledge Product Distribution
Oracle Knowledge software components and installers are distributed as licensed platform-specific media 
packages. These packages are distributed on Oracle Software Delivery Cloud or on CD-ROMs. For information 
about which media package is appropriate for your license, see the Oracle Knowledge 8.6 Release Notes.

Oracle Knowledge Features
Oracle Knowledge is a suite of components that provide enterprise class Knowledge Management functionality 
that can scale to the needs of the most demanding customer. 

Intelligent Search Provides components for Language Workbench and the associated web 
interface for defining and performing content searches.

Information Manager Provides components for content creation and management as well as iConnect 
web applications and InfoCenter integration.

Analytics Provides components for performing standard and customized performance 
metrics.

AnswerFlow Provides components for building automated solutions in response to customer 
queries.

RightNow Provides integration components necessary to integrate RightNow components.
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13   
Intelligent Search provides natural language analysis of user's questions in more than 20 languages. 
Intelligent Search includes a scalable enterprise search engine that can index web sites, file systems, 
databases, discussion forums, and other stores of knowledge including social media. Intelligent Search can be 
scaled as needed for load simply by adding additional instances to the network.

Information Manager (IM) is used to create new knowledge for use within the enterprise Knowledge Base. IM 
provides the ability to define customized templates to capture knowledge and configurable workflows to 
manage the review and publication of the knowledge. A role based security system provides coverage from 
knowledge creation thru distribution and consumption.

The Oracle Knowledge web applications include:

• InfoCenter - a reference web self service UI that can be customized by customers for their own needs. 
InfoCenter embodies some good KCS best practices that can be adapted for an organizations needs.

• iConnect - iConnect provides reference integrations to external systems such as Oracle Service Cloud, 
Siebel, and other CRM vendors products. 

Oracle Knowledge Analytics is a business intelligence application that provides insight into the effectiveness 
and performance of Oracle Knowledge Intelligent Search and Information Manager implementations. The 
Analytics application provides intuitive dashboards and packaged reports that provide insight into the most 
important aspects of search and content performance and user interaction. Analytics features near-realtime 
data integration, easy end-user access to application data for creating custom reports, and a comprehensive 
set of reporting tools packaged within Oracle's Business Intelligence presentation environment. 

The Oracle Knowledge documentation set is available at:

http://www.oracle.com/technetwork/indexes/documentation/knowledge-
documentation-1506742.html

Oracle Knowledge components
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14   INTELLIGENT SEARCH INSTANCE ENVIRONMENTS
Oracle Knowledge Environments
Oracle Knowledge architecture supports the following environments in which you configure and deploy defined 
instances, as described in each of the product chapters in this guide, to support and control the creation and 
distribution of application data.

For additional information on product-specific environments, review the sections below and see “Installation 
Process Overview” on page 19.

Intelligent Search Instance Environments
Intelligent Search is composed of a content processing instance and one or more search runtime (request 
processing) instances that are used to process search requests. The following graphic illustrates the 
relationships between components and the Development and Production environments:

Environment Description

Development Development environments can contain multiple Tools, Scheduler (default), Work Client, and Runtime 
instances used for developing and testing application components and data. The default settings in 
the Common Environment application configuration program configures a Development (also referred 
to as Standalone) environment.

Staging Staging environments are intended as separate testing environments. They support all operations. 
Staging environments can contain multiple Scheduler (default), Work Client, and Runtime instances 
used for validating application components and data prior to synchronization with production 
instances. The only way to get information into the staging environment is via propagation.

Production Production environments are intended to support scheduled operations and hands-off administration; 
they support only scheduled indexing operations and request processing operations.

Move data into production environments using the propagation process. The production environment 
can contain:

• One or more Runtime instances configured to receive application data from configured Scheduler 
instances and to communicate with the production application server

• One or more Controller instances for use by the data synchronization process
• One or more Query Worker instances for use in distributed request processing environments

Oracle Knowledge Intelligent Search Components
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Content processing can be distributed across multiple machines using work clients to improve indexing 
performance. Typically there is a single content processing instance in per environment (development, staging, 
or production) and one or more work clients available to perform indexing operations. The content processing 
instance also hosts the Search System Manager web application that is used to configure the Search 
collections and schedule indexing on the collections.

Each environment also has one or more search runtimes available. These runtimes are typically load balanced 
to allow greater scalability and fault tolerance in the environment. Depending on the size of the overall index it 
may be necessary to set up a distributed runtime environment in order to more efficiently handle the search 
requests. Configuring the distributed runtime is outside of the scope of this installation guide. More information 
can be found on the Oracle Knowledge support site.

Intelligent Search typically uses two or three different environments. The development environment is used for 
developing business rule conditions and experimenting with search tuning. The staging environment is 
typically used to perform final testing before pushing the changes to the production environment. The 
production environment is used for answering customer requirements.

The Search software must be installed in each environment separately. After the software is installed, the 
Dictionary and configuration changes can be propagated between environments using the Content processing 
instance and tasks configured in the Search System Manager.

Information Manager Instance Environments
An Information Manager application uses the following components, which are installed and configured in the 
standard installation process. You can configure Information Manager components on a single server or 
distribute them throughout a network. The following diagram illustrates the relationships between the logical 
application components:

Oracle Knowledge Information Manager components
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Analytics Instance Environments
You can use Oracle Knowledge Analytics to:

• Understand user behavior, such as why users visit your site, and what they try to achieve

• Assess the quality of Oracle Knowledge responses and determine whether users are finding the 
information they need

• Determine if important information is missing from your application content

The following diagram illustrates the Oracle Knowledge Analytics process flow:

Component Description 

Information Manager Tag 
Library Web Applications

Information Manager uses a J2EE servlet container supporting JSP version 1.2 and 
higher compatible tag libraries to distribute Information Manager application content.

Web Server An external Web server is used as the primary interface to the Information Manager 
based Web applications. 

Information Manager 
Content Resource Store

The Information Manager Content Resource Store stores resources (files) that are 
attached to content records in the application. The content resource store is a 
directory on a file system that is accessible to the Management Console and the 
application Web server. It can be located on the same server as the Management 
Console, or on a network file system. You can configure Information Manager to 
maintain separate staging and production resource stores. Resources can be served 
by separate Web servers or configured to use resource caching services (such as 
Akamai). The content resource store stores XML versions of content records used for 
search indexing, and tracks all versions of content records and attached resources.

Management Console The Management Console is a Web-based user interface to all content creation and 
management functions. The Management Console can be replicated on multiple 
servers.

There are two different configurations that a management console can run in. When 
running in "batch" mode, the IM Console should be used to process batch operations 
and content crawling requests. When running in "authoring and admin" mode, the 
instance can be used to configure the IM repository and author knowledge articles.

Database Server The Information Manager database stores the Information Manager content 
management objects. The installation process automatically creates the required 
tables in a specified database.

Information Manager Web 
Services

Information Manager provides an open set of Web services and a native platform API 
(Java and Microsoft .Net platforms) to support adding and modifying content, content 
categories, and user information from external applications.
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AnswerFlow Instance Environments
Oracle Knowledge AnswerFlow is a guided knowledge delivery application that enables you to provide 
precise and dynamic automated answers and user assistance for complex customer questions.

AnswerFlow enables you to create and deploy service processes that provides automated guidance that 

increases agent productivity and improves service quality by prompting users for guiding leveraging rich 
contextual data from internal and external systems to diagnose and resolve complex service processes with 
guided knowledge delivery. 

Some of the benefits of AnswerFlow include:

• Presents knowledge in a prescribed, repeatable manner.

• Enhances answer accuracy by bringing in additional CRM content.

• Visual process mapping to streamline service processes.

• Framework that allows transactional data to influence the service process model.

AnswerFlow is ideal in environments where delivering answers meets most or all of the following criteria:

• Answers are conditional – The answer may be based on a customers account status or the specific 
piece of equipment they are using.

• Answer diagnostics are complex – The question has many potential answers. Getting the correct 
answer involves asking several detailed questions to eliminate other possibilities.

• Answers require knowledge – Delivering the right answer requires the use of accurate information 
whether it is dynamic customer data or static corporate policies.

Oracle Knowledge Analytics components
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The components of the AnswerFlow application include:

• the Editor, which you use to create and manage AnswerFlow processes, context variables, and service 
calls

• the datastore, which stores the AnswerFlow objects

• the Runtime user interface, which you use to display AnswerFlow processes to end-users, and which 
you can customize to integrate with your application’s look and feel
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CHAPTER 2 

Planning to Install Oracle 
Knowledge

This chapter provides an overview of the installation process and describes the requirements for installing, 
configuring, and operating Oracle Knowledge products.

Installation Process Overview
The following is a summary of the tasks required for installing Oracle Knowledge:

1 Design the Knowledge Management (KM) system topology. A typical installation requires instances for 
indexing content, answering questions, creating knowledge, displaying the knowledge enhanced UI, 
analytics transformation, and reporting. Separate environments are typically configured for 
development, staging, and production usage. The WebLogic domain should be defined at this point as 
well. Load balancers, external web servers, and firewalls should be included based on the 
requirements of the organization.

2 For each environment (development, staging, production) install the pre-requisite software. A database 
server is needed with schemas for the content processing, knowledge creation, and analytics staging 
and reporting. Install WebLogic, Oracle Data Integrator, and Oracle Business Intelligence on the 
designated KM machines should be done prior to starting any of the installations of the Oracle 
Knowledge components.

3 Install the Oracle Knowledge components. The components can be installed in any order to 
accommodate the specifics of the environment being configured. In general it is a good idea to install 
all of the components of a single type (Search, IM, etc) in an environment at the same time to make 
sure that they are all working together properly. After the instances of each component are installed, 
the configuration between components can be completed as needed.

a Common Environment is a common operational environment for Oracle Knowledge applications that 
is installed and configured as part of the standard installation process. The Common Environment 
contains tools and utilities that assist in creating, administering, and maintaining Oracle Knowledge 
instances and applications, enabling you to easily:

b Intelligent Search - The Search application consists of content processing components and runtime 
components. The content processing components should be installed prior to installing the runtime 
components. Once the content processing components are installed - content collections can be 
created and the indexing process can begin. Once the indexing process is complete, the indexes 
and configuration can be synchronized and propagated to the search runtime instances in the 
environment.

c Information Manager - The IM application consists of an administration console, a web services 
application, and a JSP custom tag library that is used by the InfoCenter based web applications. 
Typically the IM admin console and web services are installed first. Once the IM admin console is 
installed, the KM system can be configured, content and users can be imported, workflows defined, 
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and IM content can be indexed by Intelligent Search. The web applications can be deployed at any 
time after an IM repository is created. This means that after running the installer for the initial 
installation, after you create the IM repository, you must run the installer again, selecting to install 
only the web applications you choose to install.

d Analytics - The analytics application consists of a JMS queue and event listener that writes incoming 
events into a staging database. Oracle Data Integrator (ODI) and Oracle Business Intelligence 
(OBIEE) is used to transform and report on the events that get generated by the Oracle Knowledge 
applications. Search and IM both need to be configured with the correct JMS queue information in 
order to send events to the Analytics subsystem. The default values should be used for a first time 
installation to avoid having to jump back and forth during the installation process. 

e AnswerFlow - the AnswerFlow application is a business process design utility that is used to 
orchestrate specific business flows to solve a specific problem. It requires access to IM and Search 
and should be installed after those components are installed and operational.

4 Perform post installation configuration and validation steps. The installers help you get all of the Oracle 
Knowledge components installed correctly. Depending on your configuration needs for a particular 
environment there must be some post installation configuration work in order for the environment to 
work together properly. This typically involves setting up load balancers, firewalls, and external web 
servers to server static content. Integrating into existing security mechanisms is out of the scope of this 
manual.

Installation Planning Worksheet
Use the following worksheet to help collect the necessary information needed to successfully install all of the 
Oracle Knowledge components in each environment. You may have multiple instances of a given component. 
You should have a detailed network architecture diagram for each environment that completely specifies the 
number of instances, load balancers, and firewall configuration.

Oracle Knowledge Installation Requirements
This section describes requirements for installing Oracle Knowledge products, including:

• Operating System requirements, as described in “Oracle Knowledge System Requirements” on page 21.

• Application server integration, as described in “Application Server Requirements” on page 21.

• Databases and database drivers, as described in “Oracle Knowledge Database Schema Requirements” 
on page 22.

Environment Host Name IP Address Type of Instance TCP Port1

1. The worksheet reflects the default port value as recommended in the installed version of Oracle Knowledge.

Development Content Processing 8222

Development Search Runtime 8223

Development InfoManager 8226

Development InfoCenter

Development IM Client Library 8226

Development WebLogic Domain Server 7001

Development WebLogic JMS queue server 

Development ODI Server

Development OBIEE Server
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• Disk space requirements, as described in “Oracle Knowledge Disk Space Requirements” on page 23.

• User permissions, as described in “Oracle Knowledge User Permissions” on page 23.

• Java Virtual Machine (JVM) allocation requirements, as described in “Oracle Knowledge Java Virtual 
Machine (JVM) Allocation Requirements” on page 24.

• Tasks necessary for acquiring and installing recommended UNIX utilities, as described in “UNIX grep, 
rm, tail, and wget Utilities” on page 24.

• Keystore requirements, as described in “Creating the Oracle Knowledge Keystore” on page 24.

• ODI requirements for Oracle Knowledge Analytics, as described in “ODI Server Requirements” on 
page 27.

• OBIEE requirements for Oracle Knowledge Analytics, as described in “Report Server (OBIEE) 
Requirements” on page 27.

Oracle Knowledge System Requirements
Oracle Knowledge has the following system requirements:

• 4 GB of RAM for each Oracle Knowledge instance (recommended)

• minimum of two processor cores (2GHz+) for each instance

Supported 64 bit operating systems include:

• Oracle Linux

• Oracle Solaris

• Red Hat Enterprise Linux

• Microsoft Windows Server

Supported databases include:

• Oracle

• Microsoft SQL Server 2008

See the Supported Environments Matrix in the Oracle Knowledge Documentation Library for complete 
information on supported operating systems, databases, application servers, and other components.

Application Server Requirements
Oracle Knowledge is supported on the following application servers:

• Oracle WebLogic

• Apache Tomcat

• IBM Websphere

We recommend that you configure a separate WebLogic domain for each Oracle Knowledge environment, and 
that you install each Oracle Knowledge application instance in a separate managed server on the domain. 
Select Sun SDK as the JDK for WebLogic domains.

See the Supported Environments Matrix in the Oracle Knowledge Documentation Library for complete 
information on supported application servers.
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Important!   See Installing and Configuring Oracle Knowledge (IBM Websphere Application Server) in the 
Oracle Knowledge Documentation Library for instruction on installing and configuring Oracle Knowledge to 
use Websphere application servers.

Oracle Knowledge Database Schema Requirements
Oracle Knowledge requires a database schema for the following components:

• Intelligent Search application content and internal data storage (needed during content processing 
operations)

• Information Manager content and metadata storage (needed for content authoring and runtime content 
access)

• Analytics staging and reporting data storage

Configure the database server to store UTF-8 formatted information to take full advantage of Oracle 
Knowledge's multilingual capabilities. Consult the appropriate product documentation for configuration 
instructions.

Requirements and Guidelines for Creating Database Schemas for Oracle 
Knowledge

We recommend that you follow these guidelines when you create database schemas:

• Create the schemas for each component with separate tablespaces for data and indexes.

• Create the Search and Information Manager schemas on a database instance specifically configured for 
OLTP operations.

• Create the Analytics schemas on a database instance specifically configured for data warehousing 
operations.

• Configure the Information Manager schemas to be case insensitive.

• Configure the Intelligent Search schemas to be case sensitive.

On SQL Server databases hosting Analytics Reporting schema, you must:

• activate row versioning to enable Read Commit Snapshot. 

• use Microsoft Data Access Components (MDAC), also known as Windows DAC, on the Report server in 
order to connect OBIEE to the SQL Server database.

VIEWING DATABASE SCHEMA INFORMATION

You can view the details of the Information Manager and Analytics database schema by browsing the data 
dictionary documentation located at:

• <IM_INSTALL_ROOT>/InfoManager/database/datadictionary.html

• <ANALYTICS_INSTALL_ROOT>/inquira/sql/documentation/DW_REPORTING/index.html

• <ANALYTICS_INSTALL_ROOT>/inquira/sql/documentation/DW_STAGE/index.html
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Microsoft SQL Server Database Collation Values

For Microsoft SQL Server databases, specify the following collation values:

The SQL Server collation values are:

• AI is Accent Insensitivity

• AS is Accent Sensitivity

• CI is Case Insensitivity

• CS is Case Sensitivity

Important!   If case sensitivity is not properly set, you may incur unique key violation errors when loading 
application data.

Oracle Knowledge Disk Space Requirements
Oracle Knowledge disk space requirements largely depend on the amount of application data to be processed. 
We recommend that a shared disk array be used to store attachments to Information Manager documents. You 
can also use shared disk space to centralize configuration information, which simplifies maintenance 
operations. The application or shared disk space should be included in a regular backup and virus-scanning 
operations. Allocate a minimum of 50 GB for each environment (development, staging, and production). 
Closely monitor the disk space usage on both the database server and the file server as content is imported.

In addition:

• The product code requires approximately 2 GB of disk space for installation and configuration.

• The application logs require up to 6 GB for each instance running under the Oracle Knowledge service.

• The application content space requirement ranges from 10 to 30 times the size of the content that you 
intend to process.

Oracle Knowledge User Permissions
To install and operate Oracle Knowledge products on Linux, you must be logged on as a non-root user. Create 
a standard Oracle Knowledge administrative user to install and run Oracle Knowledge. This user must have 
permission to access network shares while running as a service. 

In general, all of the Oracle Knowledge applications should be owned by an application user account created 
on the operating system, and not from a normal user account. For convenience, it is useful to add this 
application user account to an Administrative user group, so that other authorized administrators can view and 
edit the installation files. The owner and group should have full control over the file in the installation directory.

To install and operate Oracle Knowledge products on Windows 2008, you must be logged on as a user who 
belongs to the Administrators group.

Product or Module Database Collation

Intelligent Search All Latin1_General_CS_AS

Information Manager Application content Latin1_General_CI_AI

Analytics Staging SQL_Latin1_General_CP1_CI_AS

Analytics Reporting SQL_Latin1_General_CP1_CI_AS

Analytics ODI Work SQL_Latin1_General_CP1_CI_AS

Analytics OBIEE SQL_Latin1_General_CP1_CS_AS
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Note:   Do not install, configure, or operate other Oracle Knowledge or supplementary software components 
as a user with root privileges. The functions that Oracle Knowledge products use to maintain data integrity 
do not operate properly if the user that owns the Oracle Knowledge processes has root permissions.

Oracle Knowledge Java Virtual Machine (JVM) Allocation 
Requirements
You must allocate sufficient memory to the Java Virtual Machine (JVM) process for the Oracle Knowledge 
application and the associated Web server or application server. Configuring JVM parameters related to 
memory usage and garbage collection contributes to product performance; in general, product performance 
improves when you allocate a larger Java heap size. Optimal memory allocation, stack size, heap size, and 
garbage collection settings vary, depending on several factors, including:

• The resources available to the JVM in your environment

• The amount of application data that a given instance will be processing

UNIX grep, rm, tail, and wget Utilities
In order to use certain Common Environment commands, customers that have deployed or plan on deploying 
on Windows operating systems must install the grep, rm, tail, and wget UNIX utilities prior to installing Oracle 
Knowledge software.

Microsoft provides ports of all of the required UNIX utilities as part of their Microsoft Services for Unix (SUA) 
interoperability service package. These service packages are available at no charge from Microsoft's Web site. 
Here are links to the available packages:

• http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=23754 (Windows 2008, 
Windows Vista)

• http://technet.microsoft.com/en-us/library/cc771672.aspx (Windows 7)

• http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=20983 (Windows 2003)

The location of these files might change over time.

After the SUA package is installed and available on the SYSTEM path, the existing Common Environment 
scripts work normally. To verify that the UNIX utilities were properly installed and available inside the Common 
Environment, do the following.

1 After installing the UNIX utilities, open a command line prompt.

2 Execute one of the commands, such as grep, and see if the command responds as expected:

C:\Oracle\Knowledge\instances\MyCompany > grep
C:\Oracle\Knowledge\instances\MyCompany > Usage: grep [OPTION]... PATTERN 
[FILE]...

Use grep --help for more information.

Creating the Oracle Knowledge Keystore
You must create a single encryption keystore that all Oracle Knowledge applications use. The keystore is a 
repository for the site-specific key that encrypts all sensitive data. Oracle Knowledge uses the shared keystore 
to generate and access encrypted strings that are used across all products in your environment.
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Requirements for Creating the Keystore

You must create the keystore in a location that all Oracle Knowledge applications can access. 

Important: If you cannot place the keystore in a shared location, you must manually copy it to each Oracle 
Knowledge product installation, as described in “Manually Copying the Keystore to Additional Instances” on 
page 26. 

You must use the installation program to create the keystore and configure all products to use the keystore as 
described in “Specifying the Oracle Knowledge Keystore” on page 26.

Recommendations for Creating the Keystore

We recommend that you:

• Select a keystore location that is protected from external access

• Create a secure backup copy of the keystore

• Record the Keystore Password, Site Name, and Key Password values that you specify in “Specifying the 
Oracle Knowledge Keystore” on page 26 in a secure location for future reference

• Use the default installation keystore file permissions as described in “Keystore Access Permissions” on 
page 25

Keystore Contents

The keystore contains the following files:

Keystore Access Permissions

The installer sets the following file permissions for the keystore directory and files to enable administrators of 
other installed products to access the keystore.

DEFAULT KEYSTORE DIRECTORY PERMISSIONS

The installer sets the keystore directory permissions to 774:

DEFAULT KEYSTORE FILE PERMISSIONS

The installer sets the keystore file and wallet file permissions to 644:

File Description

ewallet.p12 This is the Oracle wallet, which stores all encrypted keys.

keystore.jks This is the keystore, which stores the public key certificates.

User Read Write Execute

Owner Yes Yes Yes

Group Yes Yes Yes

World Yes No No

User Read Write Execute

Owner Yes Yes No
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Keystore Parameters

You must specify the following information when you create the keystore during the installation process: 

Specifying the Oracle Knowledge Keystore
Each Oracle Knowledge installation program prompts you to specify the keystore location. We recommend that 
you follow this process to specify a common keystore:

• Designate a secure location that is accessible to all Oracle Knowledge products that you install.

• Specify this location when you install the first Oracle Knowledge product in your environment.

The installation program then creates the keystore in the specified location, when you have completed 
the first Oracle Knowledge product installation.

• Create a secure backup copy of the keystore directory.

• Specify this same key store location for each subsequent Oracle Knowledge installation.

Manually Copying the Keystore to Additional Instances
We recommend that you create and configure the keystore in a location that all Oracle Knowledge applications 
can access. If you cannot place the keystore in a shared location, you must manually copy it to each Oracle 
Knowledge product installation.

Important!   You must manually copy the keystore to the each instance's product directory before you start 
the installation program for each instance.

To manually copy the keystore:

• Use the installation program to create the keystore during your initial product installation as described in 
“Specifying Keystore Parameters” on page 47

• Copy the keystore directory to the desired location for each instance before starting the installation 
program for each subsequent installation

Planning the Oracle Knowledge Analytics Installation
This section describes the requirements and prerequisites for installing and configuring Analytics. 

Important!   To install Analytics, see “Installing Oracle Knowledge Analytics” on page 128.

User Requirements
The information in this chapter assumes that you have a working knowledge of how to:

Group Yes No No

World Yes No No

Keystore Password The password that protects the keystore.

Site Name The identifier for the encryption key.

Key Password The password that protects the keystore encryption key.
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• create and use Oracle and Microsoft SQL database schemas

• install and use the Weblogic server and JMS Router 

• install and use ODI

• install and use OBIEE

Analytics Installation Planning Checklist
Check the following list before, during, and after the installation to ensure all components are installed and 
configured correctly:

• verify the physical and logical requirements

• identify all the environments and servers on which you must install Analytics. 

• create the Analytics data warehouse with staging, reporting and odi_work database schemas

• calculate your tablespace requirements and add tablespace as needed

• increase the number of server processes, if needed

• modify the number of redo logs

• install the Weblogic server 

• install ODI as a standalone agent

• install OBIEE

Verifying Analytics Physical Requirements
The first step in planning your installation is to verify your physical and logical requirements.

Recommended Server and Processor Deployment

We recommend installing ODI and OBIEE on separate physical (or virtual) machines in the production 
environment. In other environments, such as Development and Staging, they can be co-located.

Analytics Server and Database Requirements

“Oracle Knowledge Installation Requirements” on page 20 describes most of the hardware, software, and 
database requirements for Oracle Knowledge applications, including Oracle Knowledge Analytics.

ODI Server Requirements

For information on hardware and software requirements to set up ODI, see Fusion Middleware Installation 
Guide for Oracle Data Integrator.

Report Server (OBIEE) Requirements

For information on OBIEE hardware and software requirements, installation requirements, and instructions for 
installing, configuring, and removing Oracle Business Intelligence products, see Fusion Middleware Installation 
Guide for Oracle Business Intelligence.
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The initial Analytics configuration process requires the OBIEE Administration Tool, which runs only on 
Windows. Consult the OBIEE documentation for specific Administration Tool requirements.

Important!   If you are using an SQL Server database, you must use Microsoft Data Access Components 
(MDAC), also known as Windows DAC, on the Report server in order to connect OBIEE to the SQL Server 
database.

Oracle WebLogic Requirements (Windows)

The Oracle Knowledge Analytics JMS Event Router is deployed to a WebLogic Server. For information and 
procedures to install WebLogic Server, see Fusion Middleware Installation Guide for Oracle WebLogic Server.

After WebLogic Server has been successfully installed, create a new domain where Analytics is deployed by 
following the instructions in Oracle Fusion Middleware Creating Domains Using the Configuration Wizard 11g.

• Be sure to configure the domain's WebLogic Startup Mode to Production Mode. Make certain that 
Tunneling is enabled on the target server.

• Be sure to select the JDK Selection as Sun SDK.

• At the end of the domain configuration wizard, select the check box to Start Admin Server.

If you have previously installed WebLogic Server and plan to use an existing domain, make sure that the 
Administration Server is running before starting the Analytics installer.

Verifying the Analytics Installation Environments
A typical Oracle Knowledge Analytics installation occurs on a number of different servers and environments. In 
general, at least one server is dedicated to data transformation (ODI) and another server is dedicated to 
reporting (OBIEE). 

You must run the Analytics installer for each of the following environments in your system; Developer, QA, 
Staging, and Production.This may result in, depending on the number of environments in your system, 
installing Analytics three or four times.

Install the Analytics components as follows:

• Install the database schemas on a dedicated server.

• Install ODI and the JMS router on a single server, or on separate dedicated servers, depending on the 
server configuration.

• Install OBIEE on a dedicated server

Verifying the Analytics Components 
The next step is to verify the Analytics components. An Analytics application consists of multiple components 
configured to extract, store, and present data collected from one or more configured Intelligent Search, 
Information Manager or Answer Flow instances. Analytics components include:

• the data warehouse, which stores the Intelligent Search and Information Manager event data in a staging 
schema, and stores reporting data in a reporting schema. It includes the staging, reporting, and 
ODI_work schemas, which create and populate the Analytics reporting and staging database tables. See 
“Creating the Analytics Data Warehouse Environment”.

• the JMS event router, which is deployed to a WebLogic server and is sent Analytics event data through 
the Java Messaging Service (JMS); it processes this event data, then stores it in the staging schema. It 
is independent upon OBIEE & ODI so make sure both are installed. 
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• a configured Oracle Data Integrator (ODI) instance to convert staging data from the staging schema to 
reporting data in the reporting schema. See the procedures in the “Installing Oracle Data Integrator 
(ODI)” section.

• a configured Oracle Business Intelligence Enterprise Edition (OBIEE) instance, which provides the user 
interface for generating, viewing, and working with reports from data in the reporting schema. See the 
“Installing Oracle Business Intelligence Enterprise Edition (OBIEE)” section.

We recommend that you install ODI and OBIEE on separate physical (or virtual) machines in the Production 
environment. In other environments, such as Development and Staging, they can be co-located.

Creating the Analytics Data Warehouse Environment
A data warehouse integrates data from various sources to a central repository and stores current and historical 
data used for creating trending reports. Data warehouses are designed to help you analyze data; for example, 
to learn more about your company's sales data, you can build a warehouse that concentrates on sales.

The Analytics data warehouse environment consists of the following requirements:

• a reporting schema

• a staging schema

• an ODI_WORK schema 

• database privileges

• database tablespace

Creating the Required Database Schemas 
Before installing Analytics, you must create the following three schemas in one database:

• a reporting schema (must be named DW_REPORTING)

• a staging schema (must be named DW_STAGE)

Note:   DW_REPORTING and DW_STAGE must have read, write, and truncate access on the WORK 
schema.

• an ODI_WORK schema (can have any name). ODI uses the work schema to manage the temporary 
tables it needs for its loading, integration and transformation from the various sources to the target. 

Adding Database Privileges to Schemas
Privileges control which users can modify database objects owned by another user. They are granted or 
revoked either by the instance administrator, a user with the ADMIN privilege or, for privileges to a certain 
object, by the owner of the object. 

If the correct level of privileges are not granted, an Insufficient privileges error may occur. To avoid these 
errors, add the following database privileges to the database schemas.
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Adding Database Privileges to Schemas on Oracle Server

Note:   For the procedure to grant or revoke privileges, see the Providing authorization to objects 
through privileges procedure located here:

http://docs.oracle.com/cd/E11882_01/timesten.112/e21633/accesscontrol.htm#TTOPR242

1 Log into the Oracle database.

2 Create the DW_STAGE, DW_REPORTING, and WORK schemas, and then grant the privilege 
statements to the schemas, as shown in the following sections.

DW_STAGE SCHEMA

Create the DW_STAGE Schema:

CREATE USER DW_STAGE
IDENTIFIED BY <password>
DEFAULT TABLESPACE <tablespace>
TEMPORARY TABLESPACE <tablespace>
PROFILE DEFAULT ACCOUNT UNLOCK;

Grant the following Privileges to the DW_STAGE Schema:

GRANT CONNECT TO DW_STAGE;
GRANT RESOURCE TO DW_STAGE;
ALTER USER DW_STAGE DEFAULT ROLE ALL;
ALTER USER DW_STAGE QUOTA UNLIMITED ON <tablespace>;
GRANT UNLIMITED TABLESPACE TO DW_STAGE;

DW_REPORTING SCHEMA

Create the DW_REPORTING Schema:

CREATE USER DW_REPORTING
IDENTIFIED BY <password>
DEFAULT TABLESPACE <tablespace>
TEMPORARY TABLESPACE <tablespace>
PROFILE DEFAULT ACCOUNT UNLOCK;

Grant the following Privileges to the DW_REPORTING Schema:

GRANT CONNECT TO DW_REPORTING;
GRANT RESOURCE TO DW_REPORTING;

Grant the following SYSTEM Privileges to the DW_REPORTING Schema:

GRANT ANALYZE ANY TO DW_REPORTING;
GRANT UNLIMITED TABLESPACE TO DW_REPORTING;

Grant the following OBJECT Privileges for the DW_REPORTING Schema

GRANT SELECT, UPDATE, DELETE ON DW_STAGE.DW_STG_DATA TO DW_REPORTING;
GRANT SELECT, UPDATE, DELETE ON DW_STAGE.DW_STG_EVENT TO DW_REPORTING;

ODI_WORK SCHEMA
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Create the ODI_WORK Schema: 

CREATE USER ODI_WORK 
IDENTIFIED BY <password>
DEFAULT TABLESPACE <tablespace>;
GRANT RESOURCE TO ODI_WORK;
GRANT CONNECT TO ODI_WORK;
ALTER USER ODI_WORK DEFAULT ROLE ALL; 
ALTER USER ODI_WORK QUOTA UNLIMITED ON <tablespace>;
GRANT UNLIMITED TABLESPACE TO ODI_WORK; 

Grant the following SYSTEM Privileges to the ODI_WORK Schema:

GRANT ANALYZE ANY TO ODI_WORK; 
GRANT DELETE ANY TABLE TO ODI_WORK;
GRANT DROP ANY TABLE TO ODI_WORK;
GRANT INSERT ANY TABLE TO ODI_WORK;
GRANT SELECT ANY SEQUENCE TO ODI_WORK;
GRANT SELECT ANY TABLE TO ODI_WORK;
GRANT UPDATE ANY TABLE TO ODI_WORK;

Using DW_REPORTING Schema as ODI_Work Schema

The ODI_WORK schema does all the work for the physical schemas (DW_REPORTING, and DW_STAGE), so 
it requires higher level privileges to access, select, update, delete, etc. on the objects owned by those 
schemas. For example, the ODI_WORK schema requires the DROP ANY TABLE privilege to truncate the 
DW_REPORTING tables to perform the ETL.

However, granting the higher SYSTEM level privilege, which is similar to a DBA privilege, may be less 
restrictive than desired and you may not want to grant these privileges to the ODI_WORK schema. The 
alternative approach is to use the DW_REPORTING schema as the ODI_WORK schema.

Adding Database Privileges to Schemas on Microsoft SQL Server

Use the following procedure to add privileges to the MSSQL server.

1 Log into SQL Server Management Studio (SSMS) as System Administrator (sa) user. 

2 Create databases named DW_STAGE, DW_REPORTING and WORK.

3 Create a login named ODIWORK.

4 Assign public and sysadmin server roles to the ODIWORK login.

5 Map the DW_STAGE, DW_REPORTING and WORK databases and ODI Repository database to the 
ODIWORK login.

Creating the Required Database Tablespaces
A database's data is collectively stored in the database's tablespace; as a database administrator, you can 
create a new tablespace (defined by an additional datafile) to increase the size of a database. 

Calculating the Tablespace Capacity

To ensure an adequate amount of database space for Analytics processing, use this procedure to calculate 
the approximate amount of tablespace you must allocate to your databases.
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1 Determine your general daily traffic (searches and documents); for example your knowledge base 
receives 5000 questions and 5000 document views.

2 Use the following algorithm to calculate how much tablespace you require, where:

- one question = 20 events, 

- one document view = 10 events 

(Q * 20) + (Doc * 10) = Total events

For the example of 5000 questions and 500 document views received:

(5000 *20) + (5000*10) = 150000 events

3 Allocate the proper tablespace. 

For each 100,000 events generated, allocate 2GB of total tablespace:

- 1.66 GB for the Staging schema

- 272 MB for the Reporting schema

For the example above, you want to allocate 4GB of tablespace.

Creating Tablespaces

Create the following tablespaces for the Analytics databases. For step-by-step instructions on creating 
tablespaces, see Oracle® Database Administrator's Guide located here:

http://docs.oracle.com/cd/B28359_01/server.111/b28310/tspaces002.htm

CREATE THE DW_STAGE TABLESPACES

Create the DW-STAGE tablespace

CREATE TABLESPACE PERF_DW_STAGE DATAFILE
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage1.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage2.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage3.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage4.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage5.dbf' SIZE 20G
NOLOGGING EXTENT MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;

Create the DW-STAGE temporary tablespace

CREATE TEMPORARY TABLESPACE PERF_DW_STAGE_TEMP TEMPFILE
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage_temp1.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage_temp2.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage_temp3.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage_temp4.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_stage_temp5.dbf' SIZE 20G;
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CREATE THE DW-REPORTING TABLESPACES

Create the DW_REPORTING tablespace.

CREATE TABLESPACE PERF_DW_REPORTING DATAFILE
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting1.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting2.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting3.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting4.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting5.dbf' SIZE 20G
EXTENT MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;

Create the DW_REPORTING temporary tablespace

CREATE TEMPORARY TABLESPACE PERF_DW_REPORTING_TEMP TEMPFILE
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting_temp1.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting_temp2.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting_temp3.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting_temp4.dbf' SIZE 20G,
'/<PATH_TO_DATAFILES_LOC>/PERF_dw_reporting_temp5.dbf' SIZE 20G;

Increasing the Number of Server Processes
You can increase the number of processes available to service requests. When you deploy more processes, 
the system can handle more requests, so increasing the number of processes increases system capacity.

1 From an SQL prompt, run the following:

show parameter processes; 

Results:

NAME TYPE VALUE 

processes integer 150 

2 Optional. If the VALUE is 150 (default) or less, run the following statement to increase:

alter system set processes=450 scope=spfile;

3 Restart the database.

Adding Redo Log Files
Redo logs store all changes made to the database as they occur; every instance of an Oracle Database has an 
associated redo log to protect the database in case of an instance failure.

Tuning the redo log options can provide performance improvement. Generally, larger redo log files provide 
better performance by reducing checkpoint activity. 

You must create at least three redo logs, and each file should be 2G. However, to maximize Analytics 
performance, we recommend that you create 10 redo log files. Each file should be about 1G.

For more information and procedures for creating redo logs, see Oracle® Database Administrator's Guide.
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Creating and Configuring a JMS Error Queue
We recommend that you set up a JMS error queue (also called error destination) for messages that have 
expired or reached their redelivery limit. If you don’t configure an error queue, then these messages are simply 
dropped.

The descriptions, definitions, and procedures for creating and configuring error queues are located here:

http://docs.oracle.com/cd/E28280_01/web.1111/e13738/basic_config.htm#JMSAD167

Note:   We recommend that you access the Oracle WebLogic Server Administration Console Online Help 
before you attempt to create a new error queue.This online help provides complete procedures for each step 
below, as well as definitions and descriptions of the JMS components and inputs. It is located here:

http://docs.oracle.com/cd/E28280_01/apirefs.1111/e13952/core/index.html

Creating an Error Queue

1 Make sure you have configured at least one JMS server.

The Configuring JMS Servers procedure is located here:

http://docs.oracle.com/cd/E28280_01/apirefs.1111/e13952/taskhelp/jms_servers/
ConfigureJMSServers.html#WLACH01907__snmp1115318

2 Start the WebLogic Administration Server.

The Start the Console procedure is located here:

http://docs.oracle.com/cd/E12839_01/apirefs.1111/e13952/taskhelp/console/StartTheConsole.html

3 Navigate to JMS Modules and select the JMS module for which you want to create an error log.

4 Select a module and select New.

a Select Lock and Edit to see all buttons.

5 Select Queue and select Next.

6 Provide a name for the error queue and JNDI and select Next.

Information about JNDI is located here:

http://docs.oracle.com/cd/E28280_01/web.1111/e13730/toc.htm#WJNDI119

7 Select or create a new subdeployment and the resulting target for the error queue, and select Finish.

The creating subdeployments procedure appears in the JMS System Module: Create Subdeployment, 
located here:

http://docs.oracle.com/cd/E28280_01/apirefs.1111/e13952/pagehelp/
JMSjmssystemmodulecreatesubdeploymenttitle.html#tasks

The Summary of Resources page appears with the new queue added to the list.

Changing the Weblogic JMS Redelivery Limit 

The redelivery limit is the number of attempts a message can make before the message is moved to a user-
specified error target destination. When a message is rolled back or recovered, the redelivery delay is the 
amount of time a message is put aside before an attempt is made to redeliver the message.
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The following procedure sets the redelivery limit attribute for a JMS queue. The default value of -1 specifies 
that the destination will not override the message sender's redelivery limit setting; in other words the redelivery 
limit is endless. We strongly recommend you change the value of this attribute to 10. 

To change the redelivery limit:

1 Log onto the Weblogic Administrator console.

2 At Domain Structure, select Services.

3 Select Messaging.

4 At the Configuration tab, select the JMS Modules > SystemModule-OracleKnowledgeModule > 
Queue-AnalyticsQueue > Delivery Failure tab.

5 At Redelivery Limit, enter the new value of 10.

For more information on the JMS message redelivery limit, see Configuring a Message Redelivery Limit On a 
Destination.

Installing Oracle Data Integrator (ODI) 
ODI is not included in the Oracle Knowledge product distribution. 

Installations that generate a large volume of analytic data require the installation of additional Java agents on 
additional servers to process the data transformation efficiently. As part of the Analytics installation process 
you must install and configure an instance of ODI as a standalone agent and at least one Java agent.

For complete information on installing and configuring ODI, see the documentation located here.

Prerequisites for Installing ODI as a Standalone Agent

Before you begin installing ODI as a stand-alone agent, make sure you have completed the following 
prerequisites:

• Installed Oracle Database 11g.

• Installed Oracle Data Integrator (ODI) 11gR1

• Created the ODI Master and Work Repositories

For complete information on installing and configuring ODI, see the documentation located here.

Installing ODI as a Stand-alone Agent
1 Navigate to your <oracle_user> location. 

2 Generate the encrypted password string with the agent command: encode.sh password. 

3 Edit the odiparams.sh. by revising the following parameters. This sets the repository connection 
information for the ODI Agent to use. 

Note:   Use the encrypted password (from step 2) for token <PUT_ENCODED_PASSWORD_HERE>.

ODI_INIT_HEAP=2048m
ODI_MAX_HEAP=8192m
ODI_CONNECTION_RETRY_COUNT=1000
ODI_MASTER_ENCODED_PASS = <PUT_ENCODED_PASSWORD_HERE>
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ODI_CONNECTION_RETRY_DELAY=31000 

4 At the Oracle Data Integrator Studio, navigate to Topology > Physical Architecture > Agent > Create 
New Agent. 

5 Create a new agent with the following values:

a agent name = a name that you assign to the agent

b agent hostname = the name of the host location 

c maximum number of sessions = 250 

d for all other fields, use the defaults

6 From the ODI locations, execute./agent.sh -NAME=<agent name> (from step 5a)

Select the test button on the upper pane for <agent name> to ensure it works properly.

7 Navigate to Topology > Contexts > New context and create a new context:

a Context name = agent name

b Create a Logical Agent for <agent name> and map all the physical agents to it.

c At Agents, associate the name of the new logical agent to the new context <agent name>. 

8 Navigate to Topology > Physical Architecture > Technologies > Oracle > oracle_server/dw_reporting

Add the context <agent name> to the target. 

9 Navigate to Topology > Physical Architecture > Technologies > Oracle > oracle_server/dw_staging

Add the Context <agent name> to the target.

10 Check the redo logs to ensure you have an adequate number. We recommend that you create 10 redo 
log files; each file should be 500M. 

SELECT 

GROUP#, 

THREAD#, 

SEQUENCE#, 

ARCHIVED, 

STATUS, 

MEMBER AS REDOLOG_FILE_NAME,

(BYTES/1024/1024) AS SIZE_MB

For example:

FROM 

v$log a JOIN v$logfile b ON a.Group#=b.Group#

ORDER BY 

GROUP# ASC; 
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11 RUN ODI using the <agent name> you created.

Increasing the ODI Repository Tablespace

After you install ODI, you may need to increase the ODI repository tablespace size.

1 In the screen Repository Creation Security: Map Tablespace select Manage Tablespace.

2 Change the tablespace size to 100GB.

3 Select OK.

Installing Oracle Business Intelligence Enterprise Edition 
(OBIEE) 
You must install and configure an instance of OBIEE before using Oracle Knowledge Analytics.

Important!   The initial Analytics configuration process depends on the OBIEE Administration Tool, which 
runs only on Windows. Consult the OBIEE documentation for specific Administration Tool requirements. 
If you are using an SQL Server database, you must use Microsoft Data Access Components (MDAC), also 
known as Windows DAC, on the Report server in order to connect OBIEE to the SQL Server database. You 
can locate Microsoft Data Access Components (MDAC) 2.8 SP1 at: http://www.microsoft.com/download/en/
default.aspx.

You can access the Oracle Business Intelligence documentation library.

Installing Oracle WebLogic Requirements (Windows)

The Oracle Knowledge Analytics JMS Event Router is deployed to a WebLogic Server. Therefore you must 
install the WebLogic Server when installing Analytics. For step-by-step procedures to install WebLogic Server, 
see the “Preparing to Install Oracle Knowledge Using WebLogic”.

After WebLogic Server has been successfully installed, create a new domain where Analytics is deployed by 
following the instructions in Oracle Fusion Middleware Creating Domains Using the Configuration Wizard 11g.

• Be sure to configure the domain's WebLogic Startup Mode to Production Mode. Make certain that 
Tunneling is enabled on the target server.

• Be sure to select the JDK Selection as Sun SDK.

• At the end of the domain configuration wizard, select the check box to Start Admin Server.

If you've previously installed WebLogic Server and plan to use an existing domain, make sure that the 
Administration Server is running before starting the Analytics installer.
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CHAPTER 3

Preparing to Install Oracle 
Knowledge Using WebLogic 

Using WebLogic Server with Oracle Knowledge
This chapter provides the following information on WebLogic server:

• Manage WebLogic Credentials

• Start Oracle Knowledge on WebLogic Server

• Find the JAVA_HOME Directory in the WebLogic Installation

Manage WebLogic Credentials
The credentials of the user used to boot the managed server are stored in encrypted form in a boot identity file 
located at $Oracle_Knowledge_ROOT/instances/<Instance_Name>/boot.properties. If the 
credentials need to be updated, the boot identity file also must be modified in order to assume the changes. 
To update the file, change the user name to be the plain-text form of the new user name and change the 
password to be the plain-text form of the new password. Restart the server and the server start process 
encrypts the values and overwrite the file. This must be done before beginning any of the OK Installations.

Start Oracle Knowledge on WebLogic Server
The Oracle Knowledge applications must be started by starting the specified managed server through the 
WebLogic Administration Console.

Managed servers can be started through the WebLogic Administration Console by using the WebLogic Server 
Node Manager. In order to start the managed server, the Node Manager must be running.

Important!   WebLogic Server must be installed, in Production mode, and the Node Manager and Admin 
Servers must be running before you start to install any of the Oracle Knowledge products. A domain must be 
created and any changes to the domain must be activated. The domain cannot be running in edit mode while 
running installers.

Starting WebLogic Administrator Console 

1 Open a command prompt. 

2 Navigate to the WebLogic Domain Path: 

<weblogic_dir>/Middleware/user_projects/domains/<Company> 

where <weblogic_dir> is the installation directory of your WebLogic Server. 
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3 On Linux, execute startWebLogic.sh. 

On Windows, execute startWebLogic.cmd

Starting and Stopping Oracle Knowledge on WebLogic Server

The Oracle Knowledge application(s) must be started by starting the specified managed server through the 
WebLogic Administration Console.

If the Search runtime instance was not deployed at the time of installation, then you must deploy it from the 
Common Environment, as described in “Create a Content Processing Instance” on page 69.

You can start Managed Servers through the WebLogic Administration Console by using the WebLogic Server 
node manager. In order to start the managed server, the node manager must be running.

On Windows, the Node Manager can be installed as a service. If the Node Manager was not installed as a 
service as part of the installation of WebLogic Server, follow the instructions for installing and removing the 
Node Manager Service in the post-installation section of the Oracle Fusion Middleware Installation Guide for 
Oracle WebLogic Server 11g.

On Linux, or if you do not want to have the Node Manager run as a service on Windows, you can start the 
Node Manager manually by following the instructions in “Start Oracle Knowledge on WebLogic Server” on 
page 38.

1 Open a command prompt.

2 Navigate to:

<weblogic_dir>/Middleware/wlserver_10.3/server/bin 

where <weblogic_dir> is the installation directory of your WebLogic Server.

3 On Linux, execute startNodeManager.sh. On Windows, execute startNodeManager.cmd.

4 The Node Manager continues running in the command prompt.

To start or stop the managed server from the WebLogic Administration Console:

1 Start the WebLogic Administration Server (if it is not running).

2 Using a Web browser, navigate to the WebLogic Administration Console URL. (Located at http://
<Administration Server Listen Address>:<Administration Server Listen Port>/
console.)

3 Provide the Administration Server's credentials to log in.

4 From the Domain Structure section, expand the Environment.

5 Select Servers to manage and control the Managed Server.

6 Select the Control tab to start and stop the Managed Server.

7 Select the check box of the Managed Server specified in the installation process.

8 Select Start or Shutdown/Force Shutdown Now.

The State of the server now reflects that the server is STARTING or FORCE_SHUTTING_DOWN (for 
Analytics, the state is FORCE_SUSPENDING).

9 Select the refresh icon above the table of servers. When the State of the server reflects that the server 
is running, the Oracle Knowledge application(s) can be accessed. When the State displays 
SHUTDOWN, the server must be restarted to access the Oracle Knowledge application(s).
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Find the JAVA_HOME Directory in the WebLogic Installation
During the Oracle Knowledge installation process, you need to input the JAVA_HOME directory that is used by 
the WebLogic server. The following instructions guide a System Administrator to find out what JAVA_HOME 
their WebLogic installation is using if they are uncertain. 

Note:   MW_HOME in these instructions refer to the Oracle Middleware Home directory (for example /home/
user/Oracle/Middleware) 

1 Navigate to <MW_HOME>/wlserver_10.3/common/bin 

2 On Linux, open the commEnv.sh file for viewing 

On Windows, open the commEnv.cmd file for viewing.

3 Find these lines in the file:

Reset JAVA_HOME, JAVA_VENDOR and PRODUCTION_MODE unless JAVA_HOME 
and JAVA_VENDOR are pre-defined. 

4 View the subsequent lines to see the directory that WebLogic sets as the default JAVA_HOME. 

Enabling Tunneling
Before running the Analytics installer, make certain Tunneling is enabled on the target server. This should be 
set by default but you may need to confirm this. To confirm, open the WebLogic Server Administration 
Console for the target domain to check. Follow this these steps:

1 Open <Domain>/Environment/Servers under Domain Structure.

2 Select the target server.

3 Open tab Protocols, subtab General.

4 If Enable Tunneling is not checked:

a Select Lock & Edit.

b Check Enable Tunneling.

c Select Save.

5 Select Activate Changes.
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CHAPTER 4

Installing Oracle Knowledge 
Intelligent Search

This chapter describes the installation process for Oracle Knowledge Intelligent Search.

Intelligent Search Installation Procedure Overview
The following installation process is required:

1 Ensure that WebLogic is installed and the Node Manager and Admin Servers are running.

2 A WebLogic domain must be configured. 

Important!   Any changes to your domain must be activated and your domain cannot be running in 
edit mode while running this installer.

3 A database schema must be created for the content store and quality monitor database.

4 If Analytics support is being installed, you must know the host name and user credentials of the 
WebLogic instance serving the queue. If you have modified the default configuration values for the 
JMS installation, you also need the JNDI information for the JMS queue and connection factory.

5 Install and configure the content processing instance.

6 Install and configure the search runtimes. 

Note:   If installing on remote servers from the Content processing instance, do not configure any 
applications within the installer, those are done from the createApp utility.

7 Verify the installation and operation of the search components is correct.

8 Configure local and remote instances for operation, as described in Creating and Configuring an 
Oracle Knowledge Application.

Running the Intelligent Search Installer
Ensure that the Node Manager server and Admin Server are both running before starting this installation.

WARNING!   Do not install Intelligent Search into an existing managed server. The application deployments 
require the managed server to make changes to the server start classpath and arguments before the server 
starts the applications 

You start the Intelligent Search installer by following the appropriate steps for your environment.
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Starting the Installer in Windows Environments
On Windows 2008, the user must be part of the Administrators group to install and operate Oracle Knowledge 
products.

To start the installer in Windows environments:

Double-click the installation file

– or –

Run the file using the command line with the following command:

install_search_<app_server>_<operating_system>_build_<#>.exe

Starting the Installer in Linux Environments
On Linux, Oracle Knowledge software must be installed using a non-root user. Before running the installer, 
create a standard Oracle Knowledge admin (Linux) user in the operating system. This user installs and runs 
the Oracle Knowledge software and must be given permission to access network shares while running as a 
service.

To start the installer in Linux environments:

1 Open a bash shell by entering bash command: 

bash

2 Use cd to go to the installer temporary directory.

3 Set the default locale for the bash shell to en_US by entering the following:

export LC_ALL="en_US"

4 Set permissions on the binary files so that they are executable by entering:

chmod +x *.bin

5 Start the installer:

./install_search_<app_server>_<operating_system>_build_<#>.bin

When the initialization progress dialog completes, the installer displays the introduction screen. The 
Installation Introduction screen recommends that all other programs running be stopped and provides 
information on operating the installer.
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6 Select Next to continue.
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Choose the Installation Location
The installer prompts you to specify the installation location. Specify the location according to the following 
requirements:

• You cannot install Intelligent Search in a location containing an existing Intelligent Search installation or 
any remaining Intelligent Search files or directories from a previous installation or installation attempt.

• You must specify an installation directory name containing no blank spaces. The Common Environment 
does not support Oracle Knowledge installation directory names containing blank spaces. Ensure that 
the target file system is large enough to install the software and create your indexes.

The default Linux location is:

<user_home>/Oracle/Knowledge/Search

The default Windows location is:

C:\Oracle\Knowledge\Search

Use the Choose option to open a file explorer and select an alternate location.

Use the Restore Default Folder option to reset the default installation directory, if necessary.

Select Next to continue.

The installer asks you to Create the Encryption Keystore.

For Apache Tomcat server, the installer prompts for the installation location and java settings for Tomcat.
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Create the Encryption Keystore
The installer prompts you to specify the location of the Oracle Knowledge keystore. If you are installing 
Search first or without Information Manager or Analytics, create a new keystore. If you have already installed 
Oracle Knowledge Information Manager or Analytics, use the same keystore created during that installation 
by selecting the location of that keystore.

For more information about the keystore, see “Creating the Oracle Knowledge Keystore” on page 24.

You must configure a keystore that is used by all Oracle Knowledge products, as described in <xref 
Specifying the Oracle Knowledge Key Store in the Planning section>. 

Specify one of the following:

• the location of an existing keystore that can be shared by all Oracle Knowledge products.

• the location of a new keystore that the installation program creates.

The default key store location is:

<INSTALL_FOLDER_PARENT>/Keystore

where:

<INSTALL_FOLDER_PARENT> is the parent folder of the top-level installation folder. For example, if you 
are installing in <user_home>/Oracle/Knowledge/Search, then the installer uses the default key 
store location: <user_home >/Oracle/Knowledge/Keystore.

Select Next to continue.
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The installation program checks whether a keystore exists in the specified location. 

If you specify a new keystore location, the installer prompts you to create the keystore, displaying the Create 
Keystore screen.

If you specify the location of an existing keystore, the installer uses the existing keystore files to encrypt the 
necessary values, as required, and displays the Install the Dictionary screen.

Create Keystore

The installation program prompts you to create the keystore.

Select Yes.

Select Next to continue.

The installation program creates the keystore and prompts you to specify key store parameters, displaying 
the Specifying Keystore Parameters screen.
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Specifying Keystore Parameters
The installer prompts you to specify keystore security parameters:

If you chose to create a new keystore, the installer prompts you to specify the following parameters:

Important!   We recommend that you record the keystore parameter values in a secure location for future 
reference.

Select Next to continue.

The installer displays the Install the Dictionary screen.

Field Description

Keystore Password The password used to protect the keystore.

Site Name The unique identifier used to identify the encryption key.

Key Password The password used to protect the encryption key in the keystore.
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Install the Dictionary
The installer prompts you to install the Dictionary. Typically, the Dictionary is installed on the Content 
Processing instance and then propagated to the runtime instances. The Dictionary should not be installed on 
remote machines by the installer.

Select Yes or No.

Select No only if you are:

• Installing over an existing Oracle Knowledge Installation and do not want to modify the existing 
Dictionary.

or

• Intending to modify the configuration to access a remote Dictionary.

Select Next to continue.

The installer displays the Select the Default Dictionary Subject Area screen.
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Select the Default Dictionary Subject Area
The installer prompts you to select the default Dictionary subject.

Select the desired default Dictionary subject. The default Dictionary subject is Customer Help. The Customer 
Help Dictionary is included as a part of all other available Dictionaries.

Select Next to continue.

The installer prompts you to Create the Application Instance.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



50   CREATE THE APPLICATION INSTANCE
Create the Application Instance
Most customers should follow the typical installation process—where you install one or more runtime 
components on a separate instance using the Create Application program.

Note:   The installer provides the option to create a consolidated installation—where both the content-
processing instance and a request processing instance are installed on the local machine. This automated 
process is generally appropriate only for small-scale purposes such as a demonstration, and not for 
production installations of any type. 

Select No to continue with a typical installation or select Yes for a consolidated installation.

Select Next to continue.

If you select No, the installer displays the Specify Java Options.

If you select Yes, the installer displays screens to specify parameters for a Consolidated Installation.
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Specify Java Options
Enter Java memory options.

Specify the following Java parameters:

Select Next to continue. 

If you use a WebLogic application server, the installer displays the Choose the WebLogic Middleware 
Home Installation Directory screen.

Option Description

Java Home used by WebLogic Specify the parent directory for the JDK bin directory used by WebLogic.

Memory Allocation Pool Initial 
Size

Specify the -XmsnM argument, where n is a number of megabytes. The default 
value is 1400.

Memory Allocation Pool 
Maximum Size

Specify the -XmxnM argument, where n is a number of megabytes. The default 
value is 2800.

Maximum Permanent Generation 
Size (WebLogic only)

Specify the -XX:MaxPermSize=nM argument, where n is a number of 
megabytes. The default value is 256.
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Choose the WebLogic Middleware Home Installation Directory

Select the root directory in which WebLogic Middleware is installed (for example, <weblogic_dir>/
<Middleware_Home>)

Select Next to continue.

If you use a WebLogic application server, the installer displays the Choose WebLogic Application Server 
Directory screen.
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Choose WebLogic Application Server Directory
The installer prompts you to specify information about your Oracle WebLogic Server environment.

WARNING!   Do not install Intelligent Search into an existing managed server.The application deployments 
require the managed server to make changes to the server start classpath and arguments before the server 
starts the applications.

Select the root directory in which WebLogic Server is installed (for example, <weblogic_dir>/
Middleware/wlserver_10.3).

Use the Choose option to open a file explorer and select an alternate location. Use the Restore Default 
Folder option to reset the default installation directory, if necessary.

Select Next to continue.

The installer confirms the WebLogic installation directory and displays an confirmation screen.

Select OK to continue.

The installer displays the Choose a WebLogic Domain screen.
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Choose a WebLogic Domain
Specify the name and location of your WebLogic domain to install the Oracle Knowledge Search components.

Enter the following:

Select Next to continue.

The installer displays the Set WebLogic Administrator Credentials screen.

Property Description

WebLogic Domain Path The full path to the WebLogic domain. The name of the WebLogic 
domain is added to the domains or user_projects folder under the 
WebLogic installation folder. For example, <weblogic_dir>/
Middleware/user_projects/domains/<domain_name>.
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Set WebLogic Administrator Credentials
Provide the credentials to the Administration Server of the specified WebLogic domain.

Enter the following:

Select Next to continue.
If you are using the consolidated installation process, the installer uses the Customer Name specified in 
Specifying Instance Parameters (Consolidated Installation) to create the following managed servers:

• <CUSTOMER_NAME>_Server (<CUSTOMER_NAME>_Machine)

• <CUSTOMER_NAME>rt1_Server (<CUSTOMER_NAME>rt1_Machine)

The installer displays the Specify Oracle Knowledge Analytics Event Messaging screen.

Property Description

Administrator User Name Specify the user name of the user used to boot the Administration Server. 
This user should already be created in WLS.

Administrator User Password Specify the password of the user used to boot the Administration Server. 

Administration Server URL Specify the <protocol>://<listen address>:<listen port> 
used to connect to the Administration Server. For WebLogic, <protocol> 
uses t3://. The default port for WebLogic installations is 7001.
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Consolidated Installation
The following sections describe the installation screens for a consolidated installation.

Specifying Instance Parameters (Consolidated Installation)

The Instance Configuration Parameters screen contains fields in which you specify the configuration 
parameters for the content processing instance and request processing instance that the installer creates.

The installer displays the Instance Configuration Parameters screen only if you specify to automatically create 
the application instances, as described in.

Specify the following instance parameters:
 

Parameter Description 

Customer name Specify the name of the default instance. The application creation process 
uses this name for the instance directory within the Oracle Knowledge 
directory structure. This name is also used as the prefix for the runtime 
instance. Specify a descriptive name, using no blank spaces within the 
directory name. 

Indexing -- host name Specify the host name for the default indexing instance. The default is 
localhost.

Indexing -- transport port Specify the port for the default instance. The default is 9000.

Indexing -- gateway port Specify the port that the application server uses. The default is 8222. 
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Select Next to continue.

The Setting Database Tables (Consolidated Installation) screen displays.

Setting Database Tables (Consolidated Installation)

If you elect to create the application instances using the installer, the installer presents options to configure 
the database connection and to create the Content Store and Quality Monitor tables.

The Set Database Parameters screen allows you to set your database connection parameters. The database 
users must already be created in order for the user validation to complete successfully.

Select your Database type: Oracle or SQL Server.

Select Next to continue.

The installer displays the Setting Database Parameters (Consolidated Installation) screen.

Request Processing -- 
host name

Specify the host name for the request processing (runtime) instance. The 
default is localhost. 

Request Processing -- 
transport port

Specify the port for the request processing (runtime) instance. The default is 
9002. 

Request Processing -- 
gateway port

Specify the port for the request processing (runtime) instance Web 
application. The default is 8223. 

Parameter (Continued) Description (Continued)
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Setting Database Parameters (Consolidated Installation)

Enter the database connection parameters

Enter the following parameters:

Select Next to continue.

The installer displays the Creating Database Tables (Consolidated Installation) screen.

Parameter Description

Database JDBC URL The JDBS URL used to connect to the database.

Database User The user name the system uses to connect to the database.

Database Password The password associated with the user name above.

Database Name  
(SQL Server ONLY)

Enter the name of the database.
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Creating Database Tables (Consolidated Installation)

The Create Content Store Table screen allows you the option to have the installer create the Content Store 
database schema. The default is No. We recommend that you select Yes.

Select Yes.

Select Next to continue.

The installer displays the Creating Quality Monitor Tables (Consolidated Installation) screen.
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Creating Quality Monitor Tables (Consolidated Installation)

The Create Quality Monitor Tables screen displays.

The Create Quality Monitor Tables screen allows you the option to have the installer create the Quality 
Monitor Tables database schema. The default is No. We recommend that you select Yes.

Select Yes.

Select Next to continue.

On Windows, the installer displays the Installing and Starting Oracle Knowledge Services (Consolidated 
Installation) screens.

On Linux, the installer displays the Specify Java Options screen.

Installing and Starting Oracle Knowledge Services (Consolidated Installation)

Select whether or not to install and start Oracle Knowledge services.

Select Yes to install and start services; select No to manually install services following the installation.

If you use WebLogic Server, the installer displays the Specify Java Options screens.

If you use Apache Tomcat Server; the installer displays the Specify Oracle Knowledge Analytics Event 
Messaging screen.
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Specify Oracle Knowledge Analytics Event Messaging
The installer prompts you to activate logging for Oracle Knowledge Analytics. 

Specify the configuration parameters to the instance of WebLogic where the Analytics event listener is 
running and monitoring the JMS queue. These values can be updated after the installation of Search or 
Analytics is completed, if necessary, by editing the <search_install_home>/config/
ok_jms.properties file.

Note:   In high-volume environments, multiple JMS queues might already exist. Make sure that you are 
configuring the correct JMS queue or event listener.

Select Yes or No.

Select Next to continue.

If you select Yes, the installer prompts you to specify JMS queue parameters so that Intelligent Search 
application data is available for use by a configured Oracle Knowledge Analytics application and displays the 
Configure the JMS Queue for Oracle Knowledge Analytics Logging screen.

If you select No, the Intelligent Search application is not configured to send data to an Analytics application 
using the JMS queue. The Analytics support files are installed, but Analytics logging is inactivated. The 
installer displays the Choose Shortcut Folder (Windows) screen or the Pre-installation Summary screen 
on Linux.
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Configure the JMS Queue for Oracle Knowledge Analytics Logging
Configure the JMS queue for Search events to be accessed by Analytics.The installer prompts you for the 
following JMS queue values:

Select Next to continue. 

The installer displays the Choose Shortcut Folder (Windows) screen or the Pre-installation Summary 
screen on Linux.

Choose Shortcut Folder (Windows)
Select the location in which you want to create shortcuts or links to Oracle Knowledge. If the installer locates 
an existing Oracle Knowledge program group on Windows, then it uses that group as the default. If the 
installer does not locate an existing Oracle Knowledge program group, then it creates a new program group. 
On Windows, you can specify:

Select the desired product icon locations.

Select Next to continue.

The installer displays the Pre-installation Summary screen.

Value Description

JMS Queue URL Specify the WebLogic Server (WLS) domain that is serving the queue.  
For example: t3://<listen address>:<listen port>

Note: The URL must contain the host name of the queue server.

JMS Queue User Specify the user ID for the WebLogic console/domain where the queue is configured.

JMS Password Specify the password for the WebLogic console/domain where the queue is configured.

JMS Factory Name Specify a JMS factory name or use the default name:  
jms/AnalyticsConnectionFactory.

JMS Queue Name Specify a JMS factory name or use the default name: jms/AnalyticsQueue 

• To create an alternate new program group in which the 
shortcuts are created

• To create Oracle Knowledge icons in another location 
which you specify

• To create shortcuts in an alternate existing program 
group

• To create icons for All Users

• To place Oracle Knowledge icons In the Start Menu, 
On the Desktop, or In the Quick Launch Bar 

• To not create Oracle Knowledge icons
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Pre-installation Summary
The Pre-Installation Summary screen displays.

Review the preinstallation summary and make any necessary changes by selecting Previous.

Select Install to continue.

The installer displays a progress screen.
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Installing the Product Files
The installer displays a progress screen during installation.

When the installation is complete, the installer displays the Installation Complete screen. 
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Installation Complete
Intelligent Search is now installed in the specified location. 

Select Done to exit the installer.

The installer executes its cleanup routines and terminates.

Restart the WebLogic Node Manager
If you chose Yes when asked if you wanted to Create the Application Instance, you must restart the 
WebLogic Node Manager. 

This is required because changes are made to the Node Manager configuration during installation and 
instance configuration that cannot take effect until the Node Manager is restarted. It must be restarted before 
the Managed Server for the Search instance can be started through the WebLogic Administration Console.

For additional WebLogic information, see “Start Oracle Knowledge on WebLogic Server” on page 38.

WebLogic Start-up Script

You can use a WebLogic start-up script to start the managed server. The 
startManagedWeblogic.sh|cmd script is provided to allow WebLogic users the ability to monitor the 
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managed servers within Oracle Process Manager and Notification Server (OPMN) or some other monitoring 
service not provided with Oracle Knowledge.

To generate the start-up script:

1 Open a command prompt and cd into $Oracle Knowledge_ROOT/instances/
<Instance_Name>, where <Instance_Name> refers to the Search instance name on this 
installation.

2 On Windows, execute setenv.bat to open the Common Environment.On Linux, execute 
createStartupScript.sh. On Windows, execute createStartupScript.

The WebLogic start managed server script is generated to $Oracle Knowledge_ROOT/
instances/<Instance_Name>. On Linux, the script is startManagedWebLogic.sh. On 
Windows, the script is startManagedWebLogic.cmd. Execute the script outside of the Common 
Environment to start the managed server.

Configuring Application Remote Clients and Data Stores
Important!   For a typical installation, you must complete the following post-installation configuration tasks. 
For a consolidated installation, you only need to complete steps 1 and 2 below.

You must complete the following steps:

1 Start the Oracle Knowledge Service.

2 Start the Common Environment.

3 Create a content processing instance.

4 Prepare the remote servers for search software installation.

5 Create remote content processing (workclient) instances on designated machines in the environment.

6 Create remote request processing (runtime) instances on designated machines in the environment.

7 Configure the application data stores.

8 Create the application database tables.

9 Restart the application.

Start Intelligent Search from the WebLogic Administration Console
To start Oracle Knowledge Search from the WebLogic Administration Console, see the instructions in “Start 
Oracle Knowledge on WebLogic Server” on page 38

You can now access the System Manager application, as described in “Accessing System Manager” on 
page 78.

Start the Oracle Knowledge Service for Intelligent Search

You can start the Oracle Knowledge service either from the Common Environment command prompt if you 
use Apache Tomcat server, or the WebLogic Administration Console for WebLogic server. On Windows, you 
must first install the service. To start the Oracle Knowledge service on the Apache Tomcat server, see “Start 
the Common Environment” on page 68.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



67   START INTELLIGENT SEARCH FROM THE WEBLOGIC ADMINISTRATION CONSOLE
The following table provides an overview of the steps necessary to start the Oracle Knowledge service on 
WebLogic, depending upon your environment.

Installing the Oracle Knowledge Service (Windows)

To install the Oracle Knowledge service:

Enter the following command at the Common Environment prompt: 

inquiraservice -install

On Windows 2008, to install, uninstall, stop, and start Oracle Knowledge services, you must execute the 
Common Environment window using the Run as Administrator option.

The Common Environment console displays information about the service installation process.

You must uninstall and reinstall the service any time you change the JVM options (JAVA_OPTS) in the 
Common Environment.

After installing the Oracle Knowledge service you must start the Oracle Knowledge service see “Start the 
Common Environment” on page 68 and then “Configuring the Application Data Stores” on page 79.

Uninstalling the Oracle Knowledge Service (Windows)

To uninstall the Oracle Knowledge service:

Enter the following command at the Common Environment prompt: 

inquiraservice -uninstall

On Windows 2008, to install, uninstall, stop, and start Oracle Knowledge services, you must execute the 
Common Environment window using the Run as Administrator option.

You must uninstall and reinstall the service any time you change the JVM options (JAVA_OPTS) in the 
Common Environment.

After uninstalling the Oracle Knowledge service you must reinstall the Oracle Knowledge service see 
“Installing the Oracle Knowledge Service (Windows)” on page 67.

Starting the Oracle Knowledge Intelligent Search Service

This must be done for both the content processing instance and the runtime instance.

If your environment is... Complete the following steps...

Typical installation on Linux with WebLogic Start the Oracle Knowledge Service as described in 
“Starting the Oracle Knowledge Intelligent Search 
Service” on page 67.

Consolidated installation on Linux with Weblogic Start the Oracle Knowledge Service as described in 
“Starting the Oracle Knowledge Intelligent Search 
Service” on page 67.

Typical installation on Windows with WebLogic Start the Oracle Knowledge Service as described in 
“Starting the Oracle Knowledge Intelligent Search 
Service” on page 67.

Consolidated installation on Windows with Weblogic Start the Oracle Knowledge Service as described in 
“Starting the Oracle Knowledge Intelligent Search 
Service” on page 67.
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You start the Oracle Knowledge service from the Common Environment command prompt for the related 
instance.

Starting Search from ICE:

1 Open a command prompt and cd into <search_install_home>/instances/
<Instance_Name>, where Instance_Name refers to the Search instance name on this installation. 

2 On Linux, execute setenv.sh to open the Common Environment. 

On Windows, execute setenv.bat to open the Common Environment.

3 On Linux, enter inquira.sh start, to start the Oracle Knowledge service.
On Windows, enter inquira start, to start the Oracle Knowledge service.

Note:   On Windows 2008, to install, uninstall, stop, and start Oracle Knowledge services, you must 
execute the Common Environment window using the Run as Administrator option.

The Oracle Knowledge service starts.

You can use the command inquira.sh stop to stop the service on Linux or inquira stop to stop 
the service on Windows.

The Intelligent Search managed servers can also be started and stopped from the WebLogic Management 
Console. See “Start Oracle Knowledge on WebLogic Server” on page 38 for more information.

Restart the Application Instance

You must restart the Oracle Knowledge application instance to make any configuration changes available to 
the applications.

To restart the Oracle Knowledge application, enter the following command from the Common Environment:

On Linux:

inquira.sh restart

On Windows:

inquira restart

Note:   The commands inquira.sh restart and inquira restart can only be executed 
successfully when the application is started by executing the inquira.sh start and inquira start 
commands.

The Search service can also be stopped and restarted using the WebLogic Administration Console. For more 
information, see “Start Oracle Knowledge on WebLogic Server” on page 38.

Start the Common Environment
When you create the Oracle Knowledge application, the Create Application program places Common 
Environment items in the Microsoft Windows Start menu for each defined instance. There are no menu items 
set up for Linux based installations. The Common Environment is used to perform the remaining tasks.

To start the Common Environment:

On Linux, open a terminal window and type:

<install_root>/instances/<Content_Processing_Instance_Name>/
enter ./setenv.sh
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On Windows, open a terminal window and type:

<install_root>/instances/<Content_Processing_Instance_Name>/
enter setenv.bat

The first time the Common Environment is accessed it may be necessary to build and deploy the web 
applications that were selected during installation. This is accomplished by following the prompts on the 
screen. 

Note:   This process is also used when a patch is applied. 

Building the web application creates the WAR file (inquirawb or inquiragw) and adds in any patches or 
updated .jar files. 

Deploying the web application copies the new WAR file to the application server container deployment folder 
and initiates the deployment process automatically.

Manage Intelligent Search from the Common Environment

You can manage the Intelligent Search application using the following Common Environment commands. You 
can access this environment from a Common Environment shortcut that is installed as part of the standard 
and stand-alone installation processes.

Note:   The commands inquira.sh/inquira restart and inquira.sh/inquira stop can only 
be executed successfully when the application is started by executing the inquira.sh start and 
inquira start commands.

Create a Content Processing Instance
On your local server, start the Create Application program by executing the following command from the 
Common Environment:

Linux:

<install_root>/bin/createApp.sh

Windows:

Use the shortcut in the Start menu or, in the Common Environment, run createApp.bat.

The Common Environment Create Application console opens, and the Common Environment Setup dialog 
displays. 

Command Description

inquira.sh start (Linux)

inquira start (Windows)

Starts the Intelligent Search services.

inquira.sh stop (Linux)

inquira stop (Windows)

Stops the Intelligent Search services.

inquira.sh restart (Linux)

inquira restart (Windows)

Stops and restarts the Intelligent Search services.
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Perform the following steps to create a Content Processing instance on the local machine:

1 Select the appropriate environment.

2 Select Create Application….

3 Click Add Scheduler (Default) Instance in the new dialog window.

The Indexing Instance dialog box displays the following:
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4 Provide a name for the instance in this environment.

5 Verify the values entered by default, click OK

6 Click Create Configuration.

Review the confirmation screen and save your changes to create the content processing instance. When you 
have finished creating the content processing instance:

1 Return to the Common Environment command line prompt. 

2 While in the same Common Environment command Window used to create the Scheduler/Indexer 
instance, run the initNavigation.{bat,sh} script, which generates the default taxonomy for the 
site.

3 Then, follow the instructions to build the web app (buildWebApp) and to deploy it (deployApp).

Prepare Remote Servers for Search Software Installation
Prior to installing Search on remote servers - it is necessary to prepare the remote servers for search 
installation. To prepare the remote servers run the Search installer but DO NOT elect to install a Dictionary or 
the web applications (content processing instance or search runtimes). The installer provides the required 
software to communicate with the createApp utility. 

On Linux, use the remote machine(s) ICE window to execute remoteInstaller.sh.

On Windows, use the remote machine(s) ICE window to execute remoteInstaller or 
remoteInstaller.bat.

Create the Remote Content Processing (Workclient) Instance
After the base Search software is installed on a remote server, you can install an instance of a content 
processing work client on it using the createApp utility. Follow these instructions:

1 Copy the keystore from the scheduler installation to this installation overriding any existing keystore.

2 Start the createApp utility from the Common Environment.

3 Select the Add Workclient Instance option. 

The Workclient Instance Details dialog displays.
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4 Fill in the required fields for the remote workclient server.

5 Select OK. 

The Create Application program attempts to connect to the specified processor, and displays 
connection status:

6 Select Yes, attempt remote installation.

If you are not creating a distributed multi-server Oracle Knowledge application Search installation 
(using remote processors) select No, create instance locally.

7 The Application Details dialog displays the settings for the defined instances that are created. Verify 
the values, click OK.

8 Click Create Configuration.

9 Review the confirmation screen and save your changes to create the content processing instance. 

If you are using a Websphere application server, then you must follow step 10 - step 12, otherwise skip 
to step 13.

10 Go to <Install_Dir>/conf directory and make a copy of websphere_template.properties 
and rename it to websphere_<instanceName>.properties. Then, replace the placeholders in 
this file with actual values. You can generate ENCRYPTED_USER_NAME and 
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ENCRYPTED_PASSWORD by using the encrypt.sh command from the ICE prompt and passing 
profile username and password on which you want to deploy the workclient application. appName and 
contextRoot being constant values for each instance type.

For workclient, these are  appName=workclient and contextRoot=/workclient.

11 Return to the Common Environment command line prompt. 

12 Run buildWebapp.sh, setServerArgs.sh and deployApp.sh to build and deploy the 
application.

13 Return to the Common Environment command line prompt.

14 Run buildWebapp and deployApp to build and deploy the application.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



74   CREATE THE REMOTE REQUEST PROCESSING (RUNTIME) INSTANCE
Create the Remote Request Processing (Runtime) Instance
After the base Search software is installed on a remote server, you can install an instance on your local 
server, the Application Details dialog displays an option to create a remote request processing (Runtime) 
instance. 

Do the following:

1 Start the createApp utility from the Common Environment.

2 Select the Add Runtime Instance option. The runtime Instance Details dialog displays.

3 Fill in the required fields for the remote runtime instance.

4 Select OK. 

The Create Application program attempts to connect to the specified processor, and displays 
connection status.

5 Select Yes, attempt remote installation.

If you are installing the Runtime instance on the local server, select No, create instance locally.
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The Application Details dialog displays the settings for the defined instances that are created.

Confirming the Distributed Application Details
On your local server, the Application Details dialog displays the parameters of the defined instances that are 
created.

Select Create Configuration.

The Oracle Knowledge Common Environment Setup dialog displays summary information about the specified 
application settings, as described in “Creating the Specified Distributed Application” on page 76. 
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Creating the Specified Distributed Application
On your local server, the Oracle Knowledge Common Environment Setup dialog displays summary 
information about the specified application settings.

1 Select Create Now. 

The instance certification is saved locally and an attempt is made to send it to each remote instance for 
which Yes, attempt remote installation was selected. If the ICE remote installer is running on each of 
these systems, each receives and saves their respective configuration.
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 You can monitor the application creation process by watching the console.

The installation is now complete, and the following message displays:

2 Select OK.
The Create Application program closes.

Restart the WebLogic Node Manager
After the installation completes, you must restart the WebLogic Node Manager. 

This is required because changes are made to the Node Manager configuration during instance configuration 
that cannot take effect until it is restarted. Specifically, if the Node Manager isn't restarted after configuring the 
instances, it will not read the changed nodemanager.properties file and will not run the 
startWebLogic.{cmd,sh} script before starting the instances, which will cause errors. It must be 
restarted before the Managed Server for the Search instance can be started through the WebLogic 
Administration Console.

For additional WebLogic information, see “Start Oracle Knowledge on WebLogic Server” on page 38.

Configure the Application Data Stores
To configure the application data stores, you access the Advanced Configuration section in System Manager. 
Before you can log into the Search System Manager web application, you must first set the administrator 
password using the Workbench utility.
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Setting the Administrator Account Password in Workbench

Perform the following steps to reset the Administrator password:

1 Open a command prompt into the Common environment for the content processing instance.

2 On Linux execute workbench.sh,  
On Windows execute workbench.bat.

3 When the Workbench utility displays, enter the following (case sensitive):

a Username: Administrator

b Password: Administrator

4 Enter the new password for the Administrator account when prompted.

You can now log into the Search System Manager console using the new password for the Administrator 
account.

Accessing System Manager

Use System Manager to configure content processing and data storage options for your application.

You must first set the Administrator password using the Workbench utility before you can to log into System 
Manager. See “Setting the Administrator Account Password in Workbench” on page 78.

The System Manager requires that the Oracle Knowledge Application Service is running.

To access System Manager:

1 Use the System Manager shortcut (on Windows). 
or 
Open a Web browser and enter the following URL:

http://<hostname>:<port>/inquirawb/

where <hostname>:<port> specifies the application server/gateway and port specified during the 
installation process, as described in “Create a Content Processing Instance” on page 69. The default 
port is 8222.

The System Manager Login page displays. The System Manager login fields are case-sensitive.

2 Log onto the System Manager as:

- User name: Administrator

- Password: <password defined in “Setting the Administrator Account Password in Workbench”>.

The System Manager displays the Job List.

3 From the Job List Screen, select the Tools menu in the upper-right portion of the screen.

4 Select Advanced Config.

The System Manager displays the Advanced Configuration page.

The Advanced Configuration Facility is divided into the following functional areas:

• System

• Instances

See the Oracle Knowledge Intelligent Search Administration Guide for more information on the Advanced 
Configuration Facility and advanced Oracle Knowledge administration.
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Configuring the Application Data Stores

An Oracle Knowledge application requires configured data sources for various types of application data. 
Using System Manager (see Starting the System Manager), you configure an application to use a single data 
source for the required data tables, which includes:

• The Content Store, which contains the indexed documents used to answer users' questions.

• The Quality Monitor data store, which stores data used for testing application request processing 
performance.

If you use the optional Oracle Knowledge Information Manager product, you must configure data sources, as 
described in the Information Manager product documentation.

You configure data sources for an application by:

• Specifying database connection information for each component

• Creating the data tables

To configure data sources for additional components, select the corresponding Advanced Configuration 
facility menu items, and configure the appropriate data sources:

See “Configuring the Application Data Stores” on page 79 for detailed content store data source configuration 
information.

See “Configuring the Quality Monitor Data Source” on page 82 for detailed Quality Monitor store data source 
configuration information.

Configuring the Content Store Data Source

The Oracle Knowledge Content Store is the database that contains the application content used in request 
processing.

You must configure a data source for the Content Store to store content for use by the application. 

You configure the data source for the Content Store by specifying appropriate values for the fields in the 
Content Store Data Sources page of the Advanced Configuration Facility.

You can use a single database as a data source for multiple Oracle Knowledge components; for example you 
can configure the same database for the Content Store and the Oracle Knowledge module.

To configure a data source for the Content Store do the following:

1 Select Content Storage from the Instances section of the Advanced Configuration Facility menu. 

The Content Storage page displays.

To Configure the 
Data Source for... Select...

Content Store Content Storage, in the Instances portion of the Advanced Configuration facility.

Quality Monitor Store Workbench, in the System section of the Advanced Configuration facility. 
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2 Select Edit on the Content Storage page. 

Content Storage page displays the list of defined data sources in the Data Source field.

3 Select Edit List in the Data Source field. 

The Data Sources page displays the currently configured data sources.

4 Select the copy icon next to appropriate sample data source, for example, SAMPLE_MSSQL.

5 Select the Data Sources name to edit that item.

The Data Sources page displays fields for entering data source information.
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6 Specify the following parameters to configure the data source:

Parameter Description 

Item Name Specify a name for the data source. The name must be a single string 
without spaces.

Datasource Type Specify the database type. Select the type of data source from the list of 
supported types (ORACLE, MSSQL).

URL Specify the connection URL for the JDBC connection. Enter the value of 
the connection URL as appropriate for your RDBMS and JDBC driver, 
for example, YOUR_HOST_NAME and YOUR_DATABASE_NAME.

User Specify the user name to use for the specified data source.

Password Specify the password to use for the specified data source. The 
Advanced Configuration Facility encrypts the saved password; the 
contents of the field might not appear to match the specified password.

Properties Specify any additional required connection properties. The sample data 
source configurations might contain additional default properties.

TDS (MS SQL Server only) Specifies the Tabular Data Stream (TDS) version. 
TDS is the protocol that SQL Server uses to communicate with 
database clients. SQL Server 2005 uses Version 8.0. Newer database 
server versions usually understand older protocol versions.

UseCursors (MS SQL Server only) Specifies that the TDS driver uses server side 
cursors instead of direct selects (AKA firehose cursors) for forward-only 
read-only result sets.

For other types of result sets, server- or client-side cursors are always 
used.

SQL Server creates a fast forward-only cursor when this property is set 
to true.
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7 Select OK to save your changes while reverting to the Content Storage page.

8 Select OK.

9 Select your newly created Data Source from the drop down list.

10 Select OK.

11 Select Save.

Configuring the Quality Monitor Data Source

The Oracle Knowledge Quality Monitor Data Store is the database that stores data used for testing 
application request processing accuracy.

You must configure a data source for the Quality Monitor Data Store to store content for use by the 
application. See in for more information. You configure the data source for the Quality Monitor by specifying 
appropriate values for the fields in the Workbench page of the Advanced Configuration Facility. It is possible 
to re-use the same schema as the Content Store database tables.

To configure a data source for the application:

1 Select Workbench from the System section of the Advanced Configuration facility menu. 

The Workbench page displays.

2 Select Edit on the Workbench page. 

Workbench page displays a drop down list of data sources.
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3 If you want to re-use the Content Store data source, select that data source. Otherwise, create a new 
data source for your Quality Monitor schema, following step 3 - step 9 under “Configuring the Content 
Store Data Source” on page 79.

4 Select OK to save your changes and return to the Advanced Configuration page.

5 Select Save on the Workbench page.

You can now create the tables for the Oracle Knowledge content store, as described in Create the Search 
Application Database Tables.

Create the Search Application Database Tables
The Common Environment provides a facility to create the Content Store and Quality Monitor database tables 
for the configured data source.

To create the content store database tables, enter the following command from the Common Environment 
prompt:

1 On Linux:

createContentStore.sh

On Windows:

createContentStore.bat

2 Restart the application instance. See the instructions under “Restarting the Application” on page 71.

To create the Quality Monitor database tables, enter the following command from the Common Environment 
prompt:

1 On Linux:

createQualityMonitorStore.sh

On Windows:

createQualityMonitorStore.bat

2 Restart the application instance. See the instructions under “Restarting the Application” on page 71.

Viewing the Oracle Knowledge Search Application Logs
The Common Environment provides a facility for viewing the STDOUT and STDERR logs for the Oracle 
Knowledge Web application.

On Windows, you must have first installed the utilities described in “UNIX grep, rm, tail, and wget Utilities” on 
page 24.

To view the application logs:

Enter the following command at the Common Environment command prompt:

tailThelog.sh –a

Oracle Knowledge displays application log information in a separate window.

See the Oracle Knowledge Intelligent Search Administration Guide for more information on Oracle 
Knowledge logs and how to access log data.
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Working with the Configured Application
The Oracle Knowledge application is now configured and ready to use. You can now begin working with the 
application to process content, schedule tasks, and develop language processing components using the 
System Manager, and additional Oracle Knowledge tools and processes.

To begin working with the application by processing content and scheduling jobs, see the Oracle Knowledge 
Intelligent Search Administration Guide.

To begin working with the application by developing language processing components, see Oracle 
Knowledge Intelligent Search Language Administration Guide and Oracle Knowledge Intelligent Search 
Language Developers' Guide.
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CHAPTER 5

Installing Oracle Knowledge 
Information Manager

This chapter describes the installation process for Oracle Knowledge Information Manager.

Oracle Knowledge Information Manager Application 
Components
An Information Manager application uses the following components, which are installed and configured in the 
standard installation process. You can configure Information Manager components on a single server or 
distribute them throughout a network.

The following table describes the relationships between the logical application components: 

Component Description 

Information Manager Tag 
Library Web Applications

Information Manager uses a J2EE servlet container supporting JSP version 1.2 and 
higher compatible tag libraries to distribute Information Manager application content.

Web Server An external Web server is used as the primary interface to the Information Manager 
based Web applications. 

Information Manager 
Content Resource Store

The Information Manager Content Resource Store stores resources (files) that are 
attached to content records in the application. The content resource store is a 
directory on a file system that is accessible to the Management Console and the 
application Web server. It can be located on the same server as the Management 
Console, or on a network file system. You can configure Information Manager to 
maintain separate staging and production resource stores. Resources can be served 
by separate Web servers or configured to use resource caching services (such as 
Akamai). The content resource store stores XML versions of content records used for 
search indexing, and tracks all versions of content records and attached resources.

Management Console The Management Console is a Web-based user interface to all content creation and 
management functions. The Management Console can be replicated on multiple 
servers.

There are two different configurations that a management console can run in. When 
running in "batch" mode, the IM Console should be used to process batch operations 
and content crawling requests. When running in "authoring and admin" mode, the 
instance can be used to configure the IM repository and author knowledge articles.

Database Server The Information Manager database stores the Information Manager content 
management objects. The installation process automatically creates the required 
tables in a specified database.

Information Manager Web 
Services

Information Manager provides an open set of Web services and a native platform API 
(Java and Microsoft .Net platforms) to support adding and modifying content, content 
categories, and user information from external applications.
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About the IM Management Console and Batch Jobs
The IM Management Console has the ability to run jobs, or processes, that maintain the repository's data 
through a job scheduling service. These jobs are referred to as batch jobs. Each non-system repository 
contains its own set of batch jobs to maintain its data. Though each repository manages its own batch jobs, 
every job in every repository is managed by a single system-wide job scheduling service. 

When a new repository is created, the system assigns a set of mandatory and standard batch jobs to it and 
registers them with the system's job scheduler. When a repository is deleted, the system unregisters the 
repository's batch jobs from the system's job scheduler.

If you are installing multiple instances of the IM Management Console, only one can be configured to run 
batch jobs, in order to maintain the integrity of the job scheduler.

The IM Management Console can be configured when you install or configured as a post-installation task.

Installing and Configuring Information Manager
The Information Manager installation process uses an automated installation program that copies the 
Information Manager product files from the product distribution and installs and configures Information 
Manager with an existing Oracle Knowledge application.

Single Server Installation
The standard installation process using the packaged installer installs and configures all Information Manager 
components on a single server. The standard process requires an existing Oracle Knowledge Intelligent 
Search instance on the target server. The stand-alone installation installs all of the necessary components to 
run Information Manager without requiring a previously installed installation of Oracle Knowledge Intelligent 
Search.

In a single server environment, the Information Manager Content Resource Store is created on the local file 
system, as follows:

If you are on WebLogic, the default location is:

<Oracle_Knowledge_home>/instances/<instance_name>/webapps/<OKResource App 
Name>/app/resources, 

where <OKResource App Name> is OKResources by default and can be configured during the 
installation process.

This folder is served by the Oracle Knowledge Resources Web application.

In a single server environment, the Web application serves images and accesses the Information Manager 
application.

Multiple Server Installation
If you install instances of Information Manager on multiple servers, you must configure each physical server 
to use a <Oracle_Knowledge_home> directory. You can accomplish this by:

• Manually copying the <Oracle_Knowledge_home> directory to each new installation

• Placing the <Oracle_Knowledge_home> directory on a networked drive that is shared by all servers 
that host Information Manager instances
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Information Manager stores configuration settings that you specify in the management console in a file, 
configuration.properties, which resides in the <Oracle_Knowledge_home> directory. The default repository 
configuration file is <Oracle_Knowledge_home>/config/SYSTEM/config.properties. When you 
change the configuration for your application repository, e.g. CUSTOMER, Information Manager stores the 
application-specific properties in <Oracle_Knowledge_home>/config/SAMPLE/config.properties.

If you are operating multiple Information Manager instances, then We recommend that you designate one 
instance as the master instance, and make configuration changes only in that instance. You can then make 
the configuration changes available to the additional instances by copying or sharing the 
<Oracle_Knowledge_home> directory.

If you are installing Information Manager on one server and Web applications on another, the tasks and refer 
to the server where the Web applications are to be installed. If you do not have a machine on the server, 
answer No to the question "Is this an existing machine on your domain?"

Important!   You must restart all applications to apply configuration changes.

You can also install the Management Console and the tag library applications on separate remote servers.

The Information Manager Content Resource Store can be stored using FTP or local copy, either on a network 
file system or on a local file system on the same server as the Management Console. The file system must be 
visible to a Web server to serve the attached resources. The file system used to store attachments for the 
Information Manager application must have read/write access for the Information Manager management 
console and other Information Manager applications that are used to create or modify content.

The Information Manager Installation Process
The Information Manager installation process uses an automated program that installs and configures:

• The Information Manager product components, including the Management Console, the JSP Tag 
Library, and the optional Information Manager Web Services.

• The Information Manager content database schema.

• Configures the IM components as managed servers in a WebLogic domain.

The installation process consists of the following steps:

1 Ensure that WebLogic is installed and the Node Manager and Admin Servers are running.

2 A WebLogic domain must be configured. 

Important!   Any changes to your domain must be activated and your domain cannot be running in 
edit mode while running this installer.

3 Start the installer, as described in “Running the Information Manager Installer” on page 88.

4 Supply the following information to the installer:

• Information about the database that you use to store Information Manager content

• Administrator passwords for the administrative repository

• Administrator email information

• Information about how you store and retrieve content resources (files such as text documents and 
spreadsheets) that are attached as supporting documents for Information Manager content items

When the installation process is complete, you can configure a Web application by: defining the application 
repository and the initial administrative user.
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Running the Information Manager Installer
Start the installer by locating and executing the appropriate version of the installer for your environment.

Starting the Installer in Windows Environments
On Windows 2008, the user must be part of the Administrators group to install and operate Oracle Knowledge 
products.

To start the installer in Windows environments:

Double-click the installation file: 

– or –

Run the file using the command line with the following command:

install_im_<app_server>_<operating_system>_build_<#>.exe

Starting the Installer in Linux Environments
On Linux, Oracle Knowledge software must be installed using a non-root user. Before running the installer, 
create a standard Oracle Knowledge admin (Linux) user in the operating system. This user installs and runs 
the Oracle Knowledge software and must be given permission to access network shares while running as a 
service.

To start the installer in Linux environments:

1 Open a bash shell by entering bash command: 

bash

2 Use cd to go to the installer temporary directory.

3 Set the default locale for the bash shell to en_US by entering the following:

export LC_ALL="en_US"

4 Set permissions on the binary files so that they are executable by entering:

chmod +x *.bin

5 Start the installer:

./install_im_<app_server>_<operating_system>_build_<#>.bin

When the initialization progress dialog completes, the installer displays the introduction screen. The 
Installation Introduction screen recommends that all other programs running be stopped and provides 
information on operating the installer.
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The Information Manager Installation Introduction
The installer's introduction screen provides general information about the installation process and 
recommends that you close any other programs that are currently running.

Select Next to continue.

The installer displays the Information Manager Administration Applications selection screen.
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Select Information Manager Administration Applications
Select the Information Manager Administration Applications you would like to install. At least one instance of 
IM Console and IM Web Services must be installed within an environment (development, staging, 
production). Until an IM repository is created, it is not be possible to deploy web applications successfully.

The installer displays the following options:

• IM Console

• IM Web Services

Select the Administration applications to install.

Select Next to continue.

The installer displays the CRM System selection screen.
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Select the CRM System
Select the CRM system with which you are integrating. Choose Other to install the base iConnect software 
for use when creating custom integrations to non supported CRM systems. Choose None to enable the 
default web self service application, InfoCenter, to be installed without installing any CRM integration support.

The installer displays the following options:

• Oracle CRM On Demand

• Siebel CRM

• Other

• None

For the initial installation, select None. After Information Manager has been installed and a repository has 
been configured, run the installer again to install CRM systems and web applications. The choice of CRM 
affects the available Web applications for installation.

Select Next to continue.

The installer displays the Choose the Web Applications to Install screen.

Note:   If Siebel CRM is selected, the installer displays the Configure Information Manager for Siebel 
CRM screen.
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Configure Information Manager for Siebel CRM

The Configure Siebel screen shows options for configuring Information Manager to integrate with Siebel 
CRM. Siebel integration requires the manual deployment of specialized Siebel Import Files (SIF) that Oracle 
Knowledge uses to communicate with your Siebel installation. In this screen are two inputs:

• Selecting the Siebel version

• Selecting the SIF location for deployment

The following are the options for the Siebel CRM version:

The default version of Siebel CRM is 8.2.

After selecting the version of Siebel CRM, select Choose to open a file browser and select the SIF location. 
Use the Restore Default Folder option to reset the default directory, if necessary.

Select Next to continue.

The installer displays the Choose the Web Applications to Install screen.

• 7.8 • 8.1 • 8.2
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Choose the Web Applications to Install
Select the Web applications to install: iConnect, iConnect for Siebel, iConnect for Oracle CRM On Demand, 
Information Center (InfoCenter), or Self-Service Portal (SSP). The Web applications can be installed 
independently or in any available combination.

The Web application choices vary with the CRM system chosen. Refer to the following table for the Web 
application choices available for each of the of CRM systems.

Note:   Installing Web applications also requires configuration to an existing Information Manager repository. 
You must complete one full installation and configure a repository before installing

Select Next to continue.

The installer displays the installation location selection screen.

CRM System InfoCenter iConnect SSP

Oracle CRM On Demand No Yes Yes

Siebel CRM Yes Yes No

Other Yes Yes No

None Yes No No
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Select the Installation Location
Select the location at which you want to install Information Manager.

The installer displays the default Oracle Knowledge installation directory:

• <user_home>/Oracle/Knowledge/IM on Linux

• C:\Oracle\Knowledge\IM on Windows

You can install at any location. The suggested location is the base Oracle Knowledge application directory for 
Information Manager (for example: C:\Oracle\Knowledge\IM on Windows).

Specify the appropriate directory.

Select Choose to open a file browser and select an alternate Oracle Knowledge base directory. Use the 
Restore Default Folder option to reset the default installation directory, if necessary.

Select Next to continue.

If the location you selected is appropriate, the installer displays the Instance Name specification screen. If the 
installer detects that the location contains an existing Oracle Knowledge Intelligent Search or Analytics 
installation or an existing Oracle Knowledge Information Manager installation with one or more of the 
applications you selected already installed, the installer prompts you to provide an alternate location. 
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Specify the InfoManager Instance Folder
Enter the InfoManager instance name where the application server is to be installed.

Enter the Instance Name.

Select Next to continue.

The installer prompts you to configure the keystore.
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Configure the Keystore
The installer prompts you to specify the location of the Oracle Knowledge keystore. If you have already 
installed Oracle Knowledge Search or Analytics, use the same keystore created during that installation by 
selecting the location of that keystore. If you are installing Information Manager without Search or Analytics, 
create a new keystore.

For more information about the keystore, see “Creating the Oracle Knowledge Keystore” on page 24.

You must configure a keystore that is used by all Oracle Knowledge products, as described in “Creating the 
Oracle Knowledge Keystore” on page 24. 

Specify one of the following:

• the location of an existing keystore that can be shared by all Oracle Knowledge products.

• the location of a new keystore that the installation program creates.

The default key store location is:

<INSTALL_FOLDER_PARENT>/Keystore

where:

<INSTALL_FOLDER_PARENT> is the parent folder of the top-level installation folder. 
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For example, if you are installing in <user_home>/Oracle/Knowledge/Search, then the installer 
uses the default key store location: <user_home >/Oracle/Knowledge/Keystore.

Select Next to continue.

The installation program checks whether a keystore exists in the specified location. 

If you specify the location of an existing keystore, the installer uses the existing keystore files to encrypt the 
necessary values, as required, and displays the Specify the Information Manager Database Type screen.

If you specify a new keystore location, the installer prompts you to create the keystore, displaying the Create 
Keystore screen. To create a new keystore, see “Create the Encryption Keystore” on page 45
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Specify the Information Manager Database Type
Select the type of database that you use for the Information Manager. The installation process prompts you to 
automatically create the database tables if they have not been created previously. See “Oracle Knowledge 
Database Schema Requirements” on page 22 in “Oracle Knowledge Installation Requirements” on page 20 
for more information on supported databases.

Select the appropriate database type.

Select Next to continue.

The installer displays the database connection properties screen.
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Specify Database Connection Properties
Specify the connection properties for the Information Manager database. The database user must already 
exist, the installer must validate the database connection information before allowing you to proceed.

Specify the appropriate values for the following database parameters:

Select Next to continue.

The installer displays the database table creation screen.

Database Property Description

Database JDBC URL Specify the connection URL for the JDBC connection. The installer populates this field 
with a template based on the specified database type and the local hostname. Edit the 
connection URL as appropriate for your RDBMS and JDBC driver.

Database User Specify the user name to use for the specified database.

Database Password Specify the password to use for the specified database.

Database Name Specify the database name. (MSSQL Server only)
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Specify Database Table Creation
Note:   This screen is only available if no Web applications are selected to be installed.

The installer prompts you to specify whether the installer automatically creates the Information Manager 
tables in the specified database. If you do not create the tables during installation, you must create the tables 
manually, as described in the Oracle Knowledge Information Manager Administration Guide prior to using 
Information Manager.

The database connection properties are stored in the $Oracle Knowledge_ROOT/InfoManager/
config/IMADMIN/application.properties and $Oracle Knowledge_ROOT/InfoManager/
config/IMWEBSERVICES/application.properties files after the installation has been completed 
successfully.

Select the desired option, then select Next to continue.

The installer displays the administration user passwords configuration screen.
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Set the Administrator Passwords
The base administrative repository named SYSTEM includes two administrative user definitions: Super 
Admin and Super Support. Specify a password for each of these user definitions.

Enter passwords for SUPER and SUPPORT administrators. Note the new passwords.

Select Next to continue. 

If you use WebLogic Server, the installer displays the screens to Configure the Application Server.

If you use Apache Tomcat Server, the installer displays the Configure Access to Information Manager 
screen.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



102   CONFIGURE THE APPLICATION SERVER
Configure the Application Server
The installer collects various parameters about your application server environment.

Specify the Java Options

Specify the Java Home, memory allocation arguments, and the garbage collection tuning argument.

Enter the following parameters:

Select Next to continue. 

Option Description

Java Home used by 
[application server]

Specify the parent directory of the JDK's bin directory (for example, /usr/lib/jvm/java-1.6.0). 
This must be the same JAVA_HOME directory used by the application server.

Memory Allocation 
Pool Initial Size

Specify the -XmsnM argument, where n is a number of megabytes. The default value is 2800.

Memory Allocation 
Pool Maximum Size

Specify the -XmxnM argument, where n is a number of megabytes. The default value is 2800.

Maximum Permanent 
Generation Size

Specify the -XX:MaxPermSize=nM argument, where n is a number of megabytes. The default 
value is 256.
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The installer displays the WebLogic middleware home installation directory screen.

Choose the WebLogic Middleware Home Installation Directory

Select the root directory in which WebLogic Middleware is installed (for example, <weblogic_dir>/
<Middleware_Home>).

Select Next to continue. 

The installer displays the WebLogic server installation directory screen.
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Choose the WebLogic Server Installation Directory

Select the root directory in which WebLogic Server is installed (for example, <weblogic_dir>/Weblogic/
wlserver_10.3).

Use the Choose option to open a file explorer and select an alternate location. Use the Restore Default 
Folder option to reset the default installation directory, if necessary.

Select Next to continue.

The installer confirms the WebLogic installation directory and displays an confirmation screen.

Select OK to continue.

The installer displays the Choose a WebLogic Domain screen.
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Choose a WebLogic Domain

Specify the name and location of your WebLogic domain where the Oracle Knowledge applications is to be 
installed.

Enter the following information:

Select Next to continue. 

The installer displays the WebLogic administrator credentials configuration screen.

Property Description

WebLogic Domain Name The name of the WebLogic domain. For example, base_domain.

WebLogic Domain Path The full path to the WebLogic domain. The name of the WebLogic domain is added to the 
domains or user_projects folder under the WebLogic installation folder. For example,  
<weblogic_dir>/Middleware/user_projects/domains/<domain_name>.
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Set the WebLogic Administrator Credentials

Provide the credentials to the administration server of the specified WebLogic domain.

Enter the following:

Select Next to continue.

The installer displays the create managed server configuration screen.

Property Description

Administrator User Name Specify the user name of the user used to boot the administration server. This 
user should already be created in WLS.

Administrator User Password Specify the password of the user used to boot the administration server.

Administration Server URL Specify the <protocol>://<listen address>:<listen port> used to 
connect to the administration server.  
For example, t3://localhost:7001.
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Create a New Managed Server (Oracle WebLogic Server)

The installation process deploys the Information Manager application(s) to a managed server in your 
WebLogic domain. This can be an existing managed server or the installation process can create a new 
managed server. We recommend to create a new managed server for the IM application components.

Select Yes if you want the installation process to create a new managed server. Select No if you plan to 
provide an existing managed server in the domain.

Select Next to continue.

The installer displays the managed server configuration screen.
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Set Managed Server Values (Oracle WebLogic Server)

If you have selected to create a new managed server, the installer uses the credentials of the administration 
server to boot the new managed server. The new managed server must be associated with a machine. The 
installation process can create a value for a new machine or you can provide the name of an existing machine 
in your domain. 

Specify the following properties:

Property Description

Managed Server Name The name of the new managed server. The name must be unique to your domain.

Listen Address The listen address of the new managed server. The default value is the local address of 
the machine running the installer.

Listen Port The listen port of the new managed server. The default value is 8226.

Machine Name The name of the machine in the domain that the new managed server is to be associated 
with. If this is a new machine, make sure that the name is unique to your domain.

Is this an existing 
machine in your domain?

Select Yes if you are providing the name of an existing machine in your domain. Select No 
if you want the installer to create a value for a new machine with this name.
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If you select to provide an existing managed server, the installer uses the credentials provided to boot the 
managed server. If credentials for the managed server are not set, leave the User Name and User Password 
fields blank and the credentials of the administration server are used to boot the managed server.

Specify the following properties:

Note:   Information Manager is deployed to the specified managed server. As a result the Information 
Manager Host is set to the managed server listen address and the Information Manager Port is set to the 
listen port. The Information Manager Host and Port are used to access the Information Manager applications 
for the WebLogic Server

Select Next to continue.

The installer displays the Set Managed Server Values confirmation screen, restating the IM host/port.

Select Next to continue.

The installer displays the screen to configure access to Information Manager.

Property Description

Managed Server Name The name of the existing managed server.

Listen Address The listen address of the existing managed server.

Listen Port The listen port of the existing managed server.

User Name The user name of the user used to boot this managed server.

User Password The password of the user used to boot this managed server.
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Configure Access to Information Manager
Specify the URL to access the Information Manager Management Console. The URL configuration property is 
stored in the <Oracle_Knowledge_home>/InfoManager/config/SYSTEM/config.properties 
after the installation has been completed successfully.

Note:   If you did not select to install an IM Console on this instance, provide the URL to access an existing 
IM Console instance.

Specify the appropriate values for the following parameter:

Select Next to continue.

The installer displays the email server configuration screen.

Property Description

Management Console URL Specify the URL for the Management Console. Default is  
http://<Information_Manager_Host>:<IM_Port>/InfoManager.
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Configure Email Properties
Specify the hostname of the email server for your organization and an Information Manager administrator 
email address. Specify whether or not the SMTP server requires authentication, and if so, provide the 
credentials Information Manager should use to send email. The email configuration properties are stored in 
the <Oracle_Knowledge_home>/InfoManager/config/SYSTEM/config.properties file after the 
installation has been completed successfully. 

Specify the following properties:

Select Next to continue. If you use WebLogic Server, the installer displays Configure the Resource Web 
Application (Oracle WebLogic Server). If you use Apache Tomcat Server, the installer displays the 
Configure a Local File System Content Resource Store screens.

Property Description 

SMTP Host Specify the hostname of the email server to use for email-related functions.

Administrator Email Address Specify the email address for the Information Manager administrator.

Requires SMTP Authentication Specify whether or not the SMTP server requires authentication.

SMTP User Name Specify the user name to be used when authenticating requests to the SMTP server.

SMTP Password .Specify the password to be used when authenticating requests to the SMTP server.
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Configure the Resource Web Application (Oracle WebLogic Server)
The installer prompts you to choose the Web application context name that is used to serve the content 
resources for the production instance. These content resources include document attachments to Information 
Manager content records as well as image uploads to the rich text editors used for composing content 
records and discussion messages.

Specify the application context name.

The default name is OKResources. This application is placed under <Oracle_Knowledge_home>/
instances/<Instance_Name>/webapps and deployed to the managed server in your domain.

Note:   Be sure that the specified context name is a unique deployment name in your domain to avoid 
duplicate deployment errors.

Select Next to continue. 

The installer displays the content resource mount point directory configuration screen.
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Configure a Local File System Content Resource Store

Specify the Content Resource Mount Point

The installer prompts you to configure a local directory referred to as the content resource mount point for 
Information Manager storage of, and access to content resources for the production instance. These content 
resources include document attachments to content records.

Specify the full path to a directory on the local file system for the location of file attachments.

The specified location must be accessible to the Oracle Knowledge application server, and the application 
server must have READ and WRITE permissions to the directory. If using a shared storage area on Linux, 
mapped drives need to be NFS mounted. If using a shared storage area on Windows, the application user 
must have permissions to login as a service and must have the appropriate network privileges. In addition, 
the UNC naming convention must be used when mapping the drive (e.g. \\Server_Name\Shared_Folder).

On WebLogic, the default location is <Oracle_Knowledge_home>/instances/<Instance_Name>/
webapps/<Context Name>/apps/resources.

On Apache Tomcat, the default location is <Oracle_Knowledge_home>/instances/
<Instance_Name>/appserverim/webapps/ROOT/resources

This directory also contains the content_xxxxx.xml files for the content crawler. The directory structure 
specified is appended to in order to create the correct path. This physical path must be available via URL in 
order for the IM content crawler from Search to index the IM repository.
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Note:   If you specify a directory that does not exist, the installation process automatically creates the 
directory.

Select Next to continue.

The installer displays the content resource URL configuration screen.

Configure the Content Resource URL

Specify a URL for the local directory that you specified as the content resource store. The default URL is 
http://<Information_Manager_Host>:<Information_Manager_Port>/<Resource_Directory 
_Name>.

Specify the URL that corresponds to the local directory specified as the content resource location. Information 
Manager uses the URL to read (retrieve) documents attached to content records in the production 
environment.

Select Next to continue.

The installer prompts you to configure any Web applications you have decided to install, as described in the 
topics that follow.

If you have not chosen any Web applications, then the installer prompts you to activate Oracle Knowledge 
Analytics logging (go to “Activate Analytics Logging” on page 119).
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Configure the Web Applications
This section describes a set of screens that allow you to configure any Web applications you have decided to 
install. There are three configuration steps:

1 “Configure the IM Console Instance to Run Batch Jobs” on page 115 (available only if IM Console is 
selected).

2 “Select the Folder Containing the CRMOD Integration Configuration Files (SSP Only)” on page 116 
(available only if SSP is selected).

3 “Specify the Web Applications Information Manager Repository” on page 118.

Configure the IM Console Instance to Run Batch Jobs

If you selected to install the IM Console Web application, the installer displays the Configuring Instance to 
Run Batch Jobs screen. The IM Console has the ability to run jobs, or processes, that maintain the 
Repository's data through a scheduling service. If you select Yes, then the installed IM Console instance can 
run these jobs and add and remove Repositories.

Specify whether this IM Console is configured to run batch jobs.

Note:   If you are installing multiple instances of the IM Console, only one should be configured to run batch 
jobs, in order to maintain the integrity of the job scheduler.

For the initial installation, we recommend that you maintain the preselected value of Yes and use this instance 
to add and remove Repositories. For subsequent installations, it is strongly recommend to select No; then the 
ability to add and remove Repositories is disabled for these instances.
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Select Next to continue.

If other Web applications are selected, the installer displays the Web application configuration screens. If not, 
the installer prompts you to activate Oracle Knowledge Analytics logging (go to “Activate Analytics Logging” 
on page 119).

Select the Folder Containing the CRMOD Integration Configuration Files (SSP 
Only)

Select the folder containing the exported CRMOD integration configuration properties files. The specified 
folder should contain the following: 

Select Choose to open a file browser and select the folder containing the exported properties files. Use the 
Restore Default Folder option to reset the default installation directory, if necessary.

Note:   This screen is available only if SSP is marked for installation.

• appconfig.properties • crmodlocalemapping.properties

• crmodconfig.properties • mapping.properties
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Select Next to continue.

The installer displays the Specify Web Apps IM Repository screen.

Note:   This screen is available only if SSP is marked for installation. If you did not select SSP for installation, 
the installer displays “Activate Analytics Logging” on page 119
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Specify the Web Applications Information Manager Repository

Note:   This screen only appears when you have selected integration Web applications to install.

Specify the reference key of the Information Manager repository for the Web applications. This repository 
must be created prior to installing the InfoCenter based web applications.

Select Next to continue. 

The installer prompts you to Activate Analytics Logging.
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Configure Analyitcs Logging
The installer displays:

• Activate Analytics Logging

• Configure the JMS Queue for Oracle Knowledge Analytics Logging

Activate Analytics Logging

The Select Activate Analytics logging screen prompts you to activate Oracle Knowledge Analytics logging.

Select Yes to display the Configure the JMS Queue for Oracle Knowledge Analytics Logging screen.

Select No only if you are not planning to install Oracle Knowledge Analytics. The installer displays Select 
Shortcut Options (Windows) or Review Installation Values (Linux).

Configure the JMS Queue for Oracle Knowledge Analytics Logging

The Select Activate Analytics logging screen prompts you to activate Oracle Knowledge Analytics logging by 
configuring a JMS queue. Oracle Knowledge Analytics product uses this JMS queue to obtain application 
data for reporting purposes.
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Select Yes to configure the JMS queue.

Note:   Select No only if you are not planning to install the Analytics package.

The installer prompts you for the following JMS queue values:

Select Next to continue. On Linux, the installer displays Review Installation Values.

On Windows, the installer displays Select Shortcut Options (Windows).

Property Description 

JMS Queue URL Specify the URL to the WebLogic Server that is serving the queue. 

For example: t3://<listen address>:<listen port>

Note: The URL must contain the host name of the queue server.

JMS Queue User Specify the user ID for the WebLogic console/domain where the queue is configured.

JMS Password Specify the password for the WebLogic console/domain where the queue is configured.

JMS Factory Name Specify a JMS factory name or use the default name:  
jms/AnalyticsConnectionFactory.

JMS Queue Name Specify a JMS factory name or use the default name: jms/AnalyticsQueue.
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Select Shortcut Options (Windows)
Select the location in which you want to create shortcuts or links to Oracle Knowledge. If the installer locates 
an existing Oracle Knowledge program group on Windows, then it uses that group as the default. If the 
installer does not locate an existing Oracle Knowledge program group, then it creates a new program group.

On Windows, you can specify:

• To create an alternate new program group in which the shortcuts are created

• To create no Oracle Knowledge icons

• To create shortcuts in an alternate existing program group

• To create icons for All Users

• To place Oracle Knowledge icons in the Start Menu, on the Desktop, or the Quick Launch Bar for the 
current user or for all users

• To create Oracle Knowledge icons in another location

Select the desired product icon locations.

Select Next to continue.

The installer displays the preinstallation summary screen.

Review Installation Values
The preinstallation summary screen displays a summary of your installation selections, as well as disk space 
information, prior to transferring the product files from the distribution.

Review your selections.

Select Previous to make any corrections.

Select Install to continue.

The installer begins installing Information Manager in the specified location.

Complete the Information Manager Installation
The completion screen summarizes the installation process.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



122   COMPLETE THE INFORMATION MANAGER INSTALLATION
The Information Manager component directories and files are now installed in the specified location.

Select Done to exit the installer.

The installer executes its cleanup routines and terminates.

After completing the stand-alone installation process on Windows 2008, the user must take ownership for the 
Oracle Knowledge installation directory, subdirectories, and objects.

The user must also have Full control permission on this directory.

The Common Environment window must be started as an administrator in order to install, uninstall, stop, or 
start the Information Manager service.

If you are using WebLogic, you must first start Information Manager. (To install Information Manager as a 
service or daemon process, see “Restart the Information Manager Service” on page 124.)

(Windows only) The installer installs the Information Manager service for you.

Starting Information Manager from the WebLogic Administration Console

To start Oracle Knowledge Information Manager from the WebLogic Administration Console, see the 
instructions in “Start Oracle Knowledge on WebLogic Server” on page 38

WebLogic Start-up Script

You can use a WebLogic start-up script to start the managed server. The 
startManagedWeblogic.sh|cmd script is provided to allow WebLogic users the ability to monitor the 
managed servers within Oracle Process Manager and Notification Server (OPMN) or some other monitoring 
service not provided with Oracle Knowledge.
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To generate the start-up script:

1 Open a command prompt and cd into $Oracle Knowledge_ROOT/instances/
<Instance_Name>, where <Instance_Name> refers to the Information Manager instance name on 
this installation.

2 On Windows, execute setenv.bat to open the Common Environment.On Linux, execute 
createStartupScript.sh. On Windows, execute createStartupScript.

The WebLogic start managed server script is generated to $Oracle Knowledge_ROOT/
instances/<Instance_Name>. On Linux, the script is startManagedWebLogic.sh. On 
Windows, the script is startManagedWebLogic.cmd. Execute the script outside of the Common 
Environment to start the managed server.

Installing the Information Manager Service (Windows)
When you install and configure Oracle Knowledge and Information Manager, the installer places Common 
Environment items in the Windows Start menu for each defined instance if product icons were selected to be 
installed.

To install the Information Manager service on Windows:

1 Select the Common Environment item for the desired instance:

Start > All Programs >Oracle Knowledge IM > <instance_name> (default) Environment

– or –

If no product icons were installed, open a command prompt and cd into 
<Oracle_Knowledge_home>/instances/<Instance_Name>  
where <Instance_Name> refers to the Information Manager instance name on this installation.  
Execute setenv.bat to open the Common Environment.

2 Install the Information Manager service by executing the following command in the Common 
Environment:

inquiraimservice -install

You can uninstall the Information Manager service by executing the following command in the 
Common Environment:

inquiraimservice -uninstall

Starting Information Manager from ICE
You can use the WebLogic Administration Console to start the managed server. See “Start Oracle Knowledge 
on WebLogic Server” on page 38 for more information.

You start the Oracle Knowledge service from the Common Environment command prompt for the related 
instance. 

Starting Information Manager from ICE:

1 Open a command prompt and cd into <InfoManager_install_home>/instances/
<Instance_Name>, where Instance_Name refers to the Information Manager instance name on 
this installation. 

2 On Linux, execute setenv.sh to open the Common Environment. 
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On Windows, execute setenv.bat to open the Common Environment. 

3 On Linux enter: inquiraim.sh start, to start the Oracle Knowledge service.

On Windows, enter: inquiraim start, to start the Oracle Knowledge service.

Note:   On Windows 2008, to install, uninstall, stop, and start Oracle Knowledge services, you must 
execute the Common Environment window using the Run as Administrator option. 

The Oracle Knowledge service starts. 

You can use the command inquiraim.sh stop to stop the service on Linux or inquiraim stop to stop 
the service on Windows. 

The Information Manager managed servers can also be started and stopped from the WebLogic 
Management Console. See “Start Oracle Knowledge on WebLogic Server” on page 38 for more information. 

You can now access the Management Console application, as described in “Access the Management 
Console” on page 126.

Restart the Information Manager Service
You must restart the Information Manager service to apply your configuration changes to the Information 
Manager Web applications.

The Common Environment window must be started as an administrator in order to install, uninstall, stop, or 
start Oracle Knowledge services.

Restart Information Manager (Linux)

To restart the Information Manager service on Linux:

1 Open a command prompt and cd into <Oracle_Knowledge_home>/instances/
<Instance_Name>, where <Instance_Name> refers to the Information Manager instance name on 
this installation. Execute setenv.sh to open the Common Environment.

2 Restart the Information Manager instance by executing the following commands in the Common 
Environment:

inquiraim.sh restart

The Oracle Knowledge service starts.

You can use the command inquiraim.sh stop to stop the service.

Note:   The commands inquiraim.sh/inquiraim restart and inquiraim.sh/inquiraim stop 
can only be executed successfully when the application is started by executing the inquiraim.sh start 
and inquiraim start commands.

Restart Information Manager (Windows)

When you install and configure Oracle Knowledge and Information Manager, the installer places Common 
Environment items in the Windows Start menu for each defined instance if product icons were selected to be 
installed.

To restart the Information Manager service on Windows:
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1 Select the Common Environment item for the desired instance:

Start > All Programs >Oracle Knowledge IM > <application_name> (default) Environment

– or –

If no product icons were installed, open a command prompt and cd into 
<Oracle_Knowledge_home>/instances/<Instance_Name> where <Instance_Name> refers 
to the Information Manager instance name on this installation.  
Execute setenv.bat to open the Common Environment.

2 Restart the Information Manager instance by executing the following command in the Common 
Environment:

inquiraim restart

The Oracle Knowledge service starts.

You can use the command inquiraim stop to stop the service.

Note:   The commands inquiraim.sh/inquiraim restart and inquiraim.sh/inquiraim stop 
can only be executed successfully when the application is started by executing the inquiraim.sh start 
and inquiraim start commands.

Manage Information Manager from the Common Environment
You can manage the Information Manager application using the following Common Environment commands. 
You can access this environment from a Common Environment shortcut that is installed as part of the 
standard and stand-alone installation processes.

Note:   The commands inquiraim.sh/inquiraim restart and inquiraim.sh/inquiraim stop 
can only be executed successfully when the application is started by executing the inquiraim.sh start 
and inquiraim start commands.

Creating a Repository
Prior to installing any of the web applications (InfoCenter, iConnect, or SSP) it is necessary to create an IM 
repository. This section describes how to create an Information Manager repository by:

• “Access the Management Console” on page 126 

• “Specify Repository Properties” on page 126.

After you create a repository, you can continue defining the various repository elements using the 
Management Console and Information Center, as described in the Oracle Knowledge Information Manager 
Administration Guide.

Command Description

inquiraim.sh start (Linux)

inquiraim start (Windows)

Starts the Information Manager services.

inquiraim.sh stop (Linux)

inquiraim stop (Windows)

Stops the Information Manager services.

inquiraim.sh restart (Linux)

inquiraim restart (Windows)

Stops and restarts the Information Manager services.
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Access the Management Console
The installation process automatically configures the Management Console for use. You can begin working 
with Information Manager by accessing the Management Console.

You can access the Management Console by:

• Selecting the installed shortcut (Windows only). The default shortcut location is All Programs > Oracle 
Knowledge IM> Information Manager.

• Navigating to the Management Console URL at http://<host_name>:<port>/InfoManager.

Log onto the IM Management Console using the following credentials:

• User name: SUPER

• Password: <The password configured during the installation process>

• Repository: SYSTEM

Create a repository for your application, as described in “Specify Repository Properties” on page 126.

Specify Repository Properties
You create a repository by specifying the properties listed in this topic.

This is an optional BUT highly recommended step.

If you are creating a repository as part of the initial Information Manager configuration, you might find it 
convenient to complete only the required fields, then specify additional properties as needed.

Property Description 

Repository Name Specify a name for the repository.

Reference Key Accept the default value supplied by the Management Console or specify a string to 
use as an internal identifier. See the note on reference keys in the Oracle Knowledge 
Information Manager Administration Guide for more information on reference keys 
and how they are used in Information Manager.

Task ID Prefix Enter a value (character string) to be used to preface task IDs in the inbox. This prefix 
is used only for consistency for document IDs in the channel and has no other system 
meaning.

Filter tasks so users are 
only made aware of tasks 
matching their skill 
category

Specify whether to filter tasks based on the presence of category expertise 
information specified in user profiles. See the information about specifying 
Management Console user properties in the Oracle Knowledge Information Manager 
Administration Guide.

Require at least one 
matching skill category 
from every top-level 
category branch

Specify whether a task is assigned to a user based on the user’s skills. If there are 
two branches (for example, Products and Departments), the user must have a user 
skill in both branches for the task to be assigned to him.

Default Locale Specify the locale (language) that is used as the default. The default locale is 
considered to be the base language for the repository. See the information about 
managing Information Manager applications in multiple languages in the Oracle 
Knowledge Information Manager Administration Guide for more information.
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Select Save Repository Properties.

The Management Console displays the new repository on the Manage Repositories page.

Supported Locales Specify optional supported locales for the repository. The default list of supported 
locales is defined in the System repository. You can modify the list of supported 
locales using the Locale Management facility, as described in the information about 
managing supported locales in the Oracle Knowledge Information Manager 
Administration Guide.

Default Administrator Define a default administrator for this repository. The Information Manager adds this 
user as a console user having the predefined Default Administrator security role. See 
the information about the Information Manager users in the Oracle Knowledge 
Information Manager Administration Guide for more information on users and security 
roles.

Workflow Tasks Specify whether to auto-assign tasks based on workflow attributes to help manage 
the task list and prevent tasks from being left unassigned.

Translation Tasks Specify whether to auto-assign tasks based on the previous translator of the record 
for the task for any new changes or modifications to the master document.

Self Administration Check these options to allow console users to join work teams, change their own 
skills (categories), and change the locales they can translate records for. This is 
normally managed by the repository administrator.

Property (Continued) Description (Continued)
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CHAPTER 6

Installing Oracle Knowledge 
Analytics

This chapter describes the installation process for Oracle Knowledge Analytics.

An Oracle Knowledge Analytics application consists of multiple components configured to extract, store, and 
present data collected from one or more configured Intelligent Search and/or Information Manager instances. 

Important!   Before using the Analytics installer, you must complete all the requirements and prerequisites 
for installing and configuring Analytics. These requirements are listed in the “Planning the Oracle Knowledge 
Analytics Installation” in this guide.

Note:   We recommend that you install ODI and OBIEE on separate physical (or virtual) machines in the 
production environment. In other environments, such as Development and Staging, they can be co-located.

Running the Analytics Installer
Important!   We strongly recommend that you log out of all programs before you install Analytics.

Start the installer by locating and executing the appropriate installer for your environment. 

Starting the Installer in Windows Environments
To start the installer in Windows environments:

Double-click the installation file

or

Run the file using the command line with the following command:

install_analytics_<app_server>_<operating_system>_build_<#>.exe

The Analytics installer starts and the introduction screen displays.

Starting the Installer in Linux Environments
To start the installer in Linux environments:

1 Open a bash shell by entering bash command: 

bash

2 Use cd to go to the installer temporary directory.

3 Set the default locale for the bash shell to en_US by entering the following:

export LC_ALL="en_US"
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4 Set permissions on the binary files so that they are executable by entering:

chmod +x *.bin

5 Start the installer:

./install_analytics_<app_server>_<operating_system>_build_<#>.bin.

When the initialization progress dialog completes, the installer displays the introduction screen. The 
Installation Introduction screen recommends that all other programs running be stopped and provides 
information on operating the installer.

Analytics Installer Introduction
The Introduction screen recommends that you stop all other programs, and provides information on operating 
the installer:

• Select Next to continue.
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Select the Analytics Installation Directory
The Choose Install Folder screen prompts you to select the installation directory.

• Select the directory where you want to install the Analytics components.

The default installation location is:

- <user_home>/Oracle/Knowledge/Analytics on Linux

- C:\Oracle\Knowledge\Analytics on Windows

We recommend that you install Analytics at the default location. However, you can install at any location by 
selecting Choose to open a file explorer and selecting an alternate location. 

You can select Restore Default Folder to reset to the default installation directory, if necessary.

• Select Next to continue.
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Choose Install Features
Select the Analytics components, or features, you want to install. The Analytics components are:

• Database Schemas. This component creates and populates the Oracle Knowledge Analytics reporting 
and staging database tables in new or existing database schemas. If you select any of the other 
features, you must select this feature as well to install the related database schemas.

Note:   When you install JMS Event Router, ODI Components or OBIEE Components, the installer 
checks that the Reporting Schema is installed. Therefore, you must always select the Database 
Schemas option to install the necessary database schemas for these options.

• JMS Event Router. This component configures and deploys the Oracle Knowledge Analytics JMS Event 
Router to the specified WebLogic domain. This option should be run from the JMS queue server.

• ODI Components. This component connects to the ODI instance and import the Oracle Knowledge 
Analytics interfaces into the ODI repository. This option should be run from the server hosting the ODI 
installation.

• OBIEE Components. This component unpacks the Oracle Knowledge Analytics OBIEE Components so 
they can be updated and imported using the OBIEE Administration Tool. This option should be run from 
the Windows machine being used to run the OBIEE BI Admin tool.

Selecting the Features to Install

You can choose to install each feature separately or all at one time; however, you must install all the features 
before you can begin using Analytics. The installation sequence varies, depending on the components you 
select. We recommend that you install the database schemas first, then JMS Event Router, then ODI, and 
finally OBIEE.

INSTALL ALL FEATURES
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• If you choose to install all the features at once, select all four features and select Next.

INSTALL DATABASE SCHEMAS

• If you choose to install only the database schemas, select Database Schemas and select Next.

INSTALL THE JMS EVENT ROUTER

• If you choose to install only the JMS Event Router, select Database Schemas and JMS Event Router 
and select Next
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INSTALL ODI COMPONENTS

• If you choose to install only the ODI Components select Database Schemas and ODI Components and 
select Next

INSTALL OBIEE COMPONENTS
.

• If you choose to install only the OBIEE Components select Database Schemas and OBIEE Components 
and select Next.
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Select the Installation Type
Select whether to install a completely new installation, or to install an Upgrade installation.

• Select Fresh to create the database objects.

• Select Next to continue.
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Select the Database Type
Select whether you will use an Oracle or SQLServer database for Analytics.

• Select the type of database (Oracle or Microsoft SQL) from the drop-down list.

• Select Next to continue.
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Configure the Database
In the next steps, specify and verify the connection to the Analytics database.

Specify Database Connection Information (Oracle)

Enter the database connection details.

• Enter the database host, port, and name. The installer attempts to validate the database connection 
information.

• Select Next to continue.
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Verify Reporting Schema Connection (Oracle Database)

Enter and confirm the reporting schema password.

• Enter and re-enter the password for the DW_REPORTING reporting schema.

• Select Next to continue.
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Verify Staging Schema Connection (Oracle Database)

Enter and confirm the staging schema password.

• Enter the password for the DW_STAGE staging schema.

• Select Next to continue.

Specify Database Connection Information (SQL Server)

Enter the database host, port, user, and password.
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• Enter the database host name, the server port number, the database user, and the database password.

• Select Next to continue.

Verify Reporting Schema Connection (SQL Server)

The installer verifies the connection to the reporting schema, DW_REPORTING.

• Enter and re-enter the password for the reporting schema DW_REPORTING.

• Select Next to continue.

Verify Staging Schema Connection (SQL Server)

The installer verifies the connection to the staging schema, DW_STAGE.

• Enter and re-enter the password for the staging schema, DW_STAGE.

• Select Next to continue.
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Create or Specify the Keystore
The installer prompts you to specify the location of the Oracle Knowledge keystore.

• If you are installing Analytics before installing Search or Information Manager (recommended), create a 
new keystore and use this keystore for subsequent installations.

• If you have already installed Oracle Knowledge Search or Information Manager, use the keystore that 
you created during that installation by selecting its location.

For more information about the keystore, see “Creating the Oracle Knowledge Keystore” on page 24.

Choose the Keystore Location

You must configure a keystore that is used by all Oracle Knowledge products.

• Specify one of the following:

- the location of an existing keystore that can be shared by all Oracle Knowledge products.

- the location of a new keystore that the installer will create.

The default key store location is:

<INSTALL_FOLDER_PARENT>/Keystore

where:

<INSTALL_FOLDER_PARENT> is the parent folder of the top-level installation folder. 

For example, if you are installing in <user_home>/Oracle/Knowledge/Analytics, then the installer uses 
the default key store location: <user_home >/Oracle/Knowledge/Keystore.

• Select Next to continue.

The installation program checks whether a keystore exists in the specified location. 

If you specify the location of an existing keystore, the installer uses the existing keystore files to encrypt the 
necessary values, as required, and displays the “Choose the Analytics Router Instance Name” on page 144 
screen.
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If you specify a new keystore location, the installer prompts you to create the keystore, displaying the Create 
Keystore screen. To create a new keystore, see “Create the Encryption Keystore” on page 45.

Specify Java Options for Service
This screen displays only if you selected to install the JMS Event Router. 

• Specify the Java Home, memory allocation arguments, and the garbage collection tuning argument for 
the JVM that starts the managed server where the JMS Event Router is deployed. Enter the following 
parameters:

• Select Next to continue.

Option Description

Java Home used by 
WebLogic

Specify the parent directory of the JDK's bin directory. For example, 
C:\Oracle\Middleware\jdk160_24 or /usr/lib/jvm/java-1.6.0.

Memory Allocation Pool 
Initial Size

Specify the -XmsnM argument, where n is a number of megabytes. The 
recommended value is 2048.

Memory Allocation Pool 
Maximum Size

Specify the -XmxnM argument, where n is a number of megabytes. The 
recommended value is 2048.

Maximum Permanent 
Generation Size

Specify the -XX:MaxPermSize=nM argument, where n is a number of 
megabytes. The recommended value is 256.
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Choose WebLogic Install Directory
Specify the directory in which the WebLogic Server you are configuring for Analytics is located.

• Select the directory in which WebLogic Server is installed 

For example:

<weblogic_dir>/Middleware/wlserver_10.3).

• Select Next to continue.
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Configure the JMS Event Router
The installer configures and deploys the JMS Event Router to the specified WebLogic domain.

Note:   If you did not select the Install JMS Event Router option, you will not see this screen.

• Make sure that your target domain is configured with the options specified in the installation instructions 
before proceeding. 

• Make sure the Admin server and Node Manager are running prior to executing the following steps so the 
installer can properly configure the JMS queue and deploy the Oracle Knowledge Event Router.

• Select Next to continue.
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Choose the Analytics Router Instance Name

Enter a name for the Analytics Event Router. We recommend that you use the default name, 
AnalyticsEventRouter.

• Enter the name AnalyticsEventRouter in the Instance Name field.

Analytics creates a folder with this instance name under the <INSTALL_ROOT>/instances directory. 

• Select Next to continue.
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Choose a WebLogic Domain

Specify the WebLogic domain in which you want to install the Analytics Event Router.

• Choose the WebLogic domain directory to which you want to install the event router, for example, 
<user_home>/Oracle/Middleware/user_projects/domains/<domain_name>. 

Note:   We recommend that you install the event router in a new managed server.

• Select Next to continue.
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Set the WebLogic Administrator Credentials

Provide the credentials to the administration server of the specified domain.

• Enter the following properties:

• Select Next to continue.

Property Description

Administrator User Name Specify the user name of the user used to boot the administration server.

Administrator User Password Specify the password of the user used to boot the administration server.

Administration Server URL Specify the <protocol>://<listen address>:<listen port> 
used to connect to the administration server.
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Set the Managed Server Values

The installation process creates a new managed server and machine in the WebLogic domain. The installer 
uses the credentials of the administration server to boot the new managed server. The new managed server is 
associated with the machine.

• Enter the following properties:

• Select Next to continue.

Property Description

Managed Server Name Specify the name of the new managed server. Make sure that the name is 
unique to your domain.

Listen Address Specify the listen address of the new managed server. The default value is the 
local address of the machine running the installer.

Listen Port Specify the listen port of the new managed server. The default value is 7002.

Machine Name Specify the name of the new machine to which the new managed server is 
associated. Make sure the machine name is unique to your domain.
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Set JMS Queue Parameters

We recommend that you use the defaults when you set the JMS queue parameters. If you are installing the 
Analytics Event Router on an existing WebLogic domain, make sure you change one or more WebLogic 
names to avoid conflicts with existing objects. 

If you don’t use the defaults, record the values you enter; they must be provided to other component installers 
for their Analytics logging support.

• Enter the following parameters, then select Next to continue:

Important!   The JNDI parameter default values must be retained. Changing these values could render 
Analytics unusable.

Parameter Default Value Description 

JMS Factory Name ConnectionFactory-
AnalyticsConnectionFactory

The WebLogic name of the 
Analytics JMS Connection Factory.

JMS Factory JNDI Name jms/AnalyticsConnectionFactory The JNDI name of the Analytics 
JMS Connection Factory.

JMS Queue Name Queue-AnalyticsQueue The WebLogic name of the 
Analytics JMS queue.

JMS Queue JNDI Name jms/AnalyticsQueue The JNDI name of the Analytics 
JMS queue.

JMS Persistent Store Name Queue The WebLogic name of the 
Analytics JMS queue's file store.

JMS Persistent Store 
Location

<domain path>/queuePersistence The directory where the Analytics 
JMS queue's file store is located.
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Choose the ODI Install Location
If you selected to install ODI, choose the location for the ODI installation; this can be any location. 

• Select the directory where ODI is installed.

• Select Next to continue.
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Choose the ODI Components Location

The ODI components include all of the interfaces for the master repository, work repository, and logical 
repository. These interfaces are imported by the installer later.

• Select the location to unpack the ODI components; this can be any location. 

• Select Next to continue.
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Choose the OBIEE Components Location

If you selected to install OBIEE, this screen displays.

The OBIEE components include the RPD file, the web catalog, and the CSS file.

• Select the location for the installer to unpack the OBIEE components. This can be any location on a 
Windows machine. 

• Select Next to continue.
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Verify the Installation Specifications

• Check your selections in the Pre-installation Summary screen. To modify any selections, select 
Previous until you get back to the screen where you need to make a change. 

• Select Install to start the installation process.
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Installing Oracle Knowledge Analytics
The Installing Oracle Knowledge Analytics screen shows the progress of the installation. 

Note:   Installing the reporting schema might take a substantial length of time.
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Importing the ODI Components
The installer displays a notice about the ODI import process. The installer will import the ODI components into 
the specified locations, and will create log files that you can use to monitor progress. The log files are located 
in the /Analytics/logs sub-directories of the installation directory. The log filenames are:

• Select Next to continue. 

The installer deploys the ODI components and continues to complete the installation.

Component Log Filename

Master Repository import_master.log

Logical Topology import_logical.log

Work Repository import_work.log
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Complete the Installation Process
The Install Complete screen summarizes the installation process. The Analytics component directories and 
files are now installed in the specified location. 

• Depending on the options chosen during the installation, there may be additional work that needs to be 
performed after the installation.

• Select Done to exit the installer.
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Completing the Analytics Installation
You must perform these procedures to complete the Analytics installation.

Procedures Description

Databases 

Validating the Database Schemas

Validating the Reporting Schema

Validating the Staging Schema

Use these procedures to check that the database schemas 
were created and populated

JMS Queue and Event Router

Validating JMS Queue and Event Router 
Installation

Use this procedure to verify the JMS installation by checking 
the configuration of the WebLogic domain.

ODI

Configuring the ODI

Validating the ODI Installation

Connecting ODI to an Oracle Database

Connecting ODI to an SQLServer 
Database

Additional Task for Customers Using an 
Oracle 12c or Oracle RAC Database

Use these procedures to validate the ODI interfaces and set 
the database connections.

OBIEE

Completing the OBIEE Installation

Connect OBIEE to the Data Warehouse

Configuring Connections to the 
Database

Open the RPD

Change the RPD PasswordConnecting to 
the Reporting Schema

Use these procedures to configure the OBIEE RPD and 
apply the styles and formatted needed to view Analytic 
reports.
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Validating the Database Schemas
This section describes how to validate the staging, reporting, and work database schemas. 

Validating the Staging Schema

Check that:

• the INSTALL_HISTORY table in the DW_REPORTING schema indicates that the DW_STAGE schema 
was populated

• the DW_EVENT_DEFINITION table is populated with the list of available analytics events

Validating the Reporting Schema 

Check that the INSTALL_HISTORY table has a record for each of the operations performed by the installer.

Validating JMS Queue and Event Router Installation 
Validate the JMS Queue and Event Router installation by inspecting the WebLogic domain configuration. 

To validate the installation:

1 Open the Oracle WebLogic Server Administration Console in a browser.

2 Navigate to the Domain Structure panel (left side of the screen) to verify that the JMS router and JMS 
queue components are installed.

• Select Environment > Servers to verify the server you specified during install time appears in the 
Servers list.

• Select Environment > Machine to verify the machine you specified during install time appears in 
the Machines list.

• Select Deployment to verify that AnalyticsEventRouterEA-8.6.0.0 is listed as a deployable that 
can be started or stopped in the Deployments list.

• Select Services > Messages > JMS Servers to verify that JMSServer-
OracleKnowledgeAnalytics appears in the JMS Servers list.

• Select Services > Messages > JMS Modules to verify that SystemModule-
OracleKnowledgeModule appears in the JMS Modules list.

• Select JMS Modules > Connection Factory to verify that AnalyticsConnectionFactory (default 
name) appears in the JMS Connection Factory list. This is the connection factory to which the 
Information Manager and Intelligent Search applications connect.

• Select Services > Data Sources to verify that JDBC/AnalyticsDataSource appears in the Data 
Source list.This points to the staging database host and DW_STAGE schema.

• Select Services > Persistent Stores to verify that JDBC/AnalyticsDataSource appears in the 
Queue (default name) list.
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Configuring the ODI 
This section describes how to validate the ODI installation, connect ODI to the databases and configure the 
ODI agent.

Validating the ODI Installation

The Analytics installer connects to the ODI instance and automatically imports the Oracle Knowledge Analytics 
interfaces into the ODI repositories. These interfaces represent the transforms that convert the incoming 
analytics events into reporting data. 

Validate that the import process succeeded by:

• opening the ODI repository using the ODI admin tool

• locating the interfaces that were imported during the install process

To check that the installer imported the interfaces:

• Select Designer > Projects > DW_Data_Loads > DW_Data_Loads > Interfaces. 

If the import process is successful, the Analytics interfaces appear in the Interfaces list. These interfaces 
represent the transforms that convert the incoming analytics events into reporting data.

If you do not see the interfaces, import them manually using the procedure "Import the Analytics ODI 
Components Manually" on page 186. 

Connecting ODI to an Oracle Database 

You must configure ODI to connect to the Analytics database. To configure ODI for an Oracle database:

1 In the Topology tab, select Physical Architecture > Technologies > Oracle > 
ORACLE_SERVER.

2 In the Definition tab:

- Under (Instance / dblink (Data Server)), enter the reporting and staging schemas' database's TNS 
name.

- Enter the ODI work schema name and password (as created in “Running the Analytics Installer” on 
page 128) under User and Password, respectively.

3 In the JDBC tab, enter the JDBC connection string 
(jdbc:oracle:thin:@<host>:<port>:<SID>) of the database.

4 Select Test Connection to save and test the connection.

5 Expand the ORACLE_SERVER node under Topology.

6 Select ORACLE_SERVER.DW_REPORTING and enter the ODI work schema name under Schema 
(Work Schema).

7 Select ORACLE_SERVER.DW_STAGING and enter the ODI work schema name under Schema 
(Work Schema).
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Connecting ODI to an SQLServer Database 

You must configure ODI to connect to the Analytics database. To configure ODI for an SQLServer database:

1 In the Topology tab, select Physical Architecture > Technologies > Microsoft SQL 
Server> SQL_SERVER.

2 In the Definition tab:

- Under Data Server, enter the database server name.

- Under Connection, enter the username and password to connect to the database.

3 In the JDBC tab, enter the JDBC connection string  
(jdbc:web l o g i c : s q l s e r v e r : / /<ho s t>:<po r t>) of the database.

4 Select Test Connection to save and test the connection.

5 Expand the SQL_SERVER node under Topology.

6 Select SQL_SERVER.DW_REPORTING.dbo and enter the ODI work schema name for Database 
(Work Catalog).

7 Select SQL_SERVER.DW_STAGE.dbo and enter the ODI work schema name for Database (Work 
Catalog).

Configure the ODI Agent

The basic installation of ODI installs both the standalone agent and the Java agent. Agents are used to 
execute the ODI packages to perform the transforms. 

Note:   For Analytics, you must install the ODI agent as Standalone. See the “Installing Oracle Data 
Integrator (ODI)” procedure in this guide.

Additional Task for Customers Using an Oracle 12c or Oracle RAC Database

Use this procedure if you are using the Oracle 12c or Oracle RAC database only. It replaces the existing SQL 
query with an updated query. 

1 Log into ODI and select your work repository.

2 Select the Designer tab.

3 Expand DW_Data_Loads. 

4 Expand Procedures and open the UPDATE_BRIDGE_QUESTN_RESPONSE_STG procedure.

5 Select Details and open the UPDATE_BRG_QUES_RESPONSE_STG_U_DUPLICATE step.

6 Select Command On Target.

You see the existing SQL query.

7 Replace the existing SQL query with the following query:

UPDATE dw_reporting.bridge_questn_response_stg
SET ind_upd = 'U'
WHERE ind_upd = 'I'
AND (data_id, questn_key) NOT IN

(
SELECT max(data_id), questn_key
FROM (
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SELECT data_id, questn_key, response_key, brg_num_in_set,
ind_upd,

row_number() OVER (PARTITION BY  questn_key ,
brg_num_in_set ORDER BY data_id) AS rownumber

FROM (
select data_id, questn_key,

brg_num_in_set,ind_upd,output as response_key
from
(select data_id, questn_key,

brg_num_in_set,ind_upd, listagg(response_key,',') WITHIN GROUP (ORDER BY
data_id ) over (partition by data_id ) as output,

count(response_key) over (partition by
data_id order by response_key) as running_count,

count(response_key) over (partition by
data_id) as tot_count

from (SELECT * FROM
dw_reporting.bridge_questn_response_stg ORDER BY questn_key, response_key))

where running_count = tot_count
)

)
group by questn_key,response_key
)

8 Save all the changes.

9 At the Designer tab, expand DW_Data_Loads > Packages option.

10 Expand the PKG-LOAD_FACT_AGG_TABLES_PUBLISH package.

11 Expand Scenarios.

12 Right click on the PKG_LOAD_FACT_AGG_TABLES_PUBLISH Version 001 scenario and select 
Regenerate. 

13 Click Ok on the scenario regeneration box.

14 Continue with the tasks in the “Configuring the ODI”section of this guide

Completing the OBIEE Installation
You install OBIEE for Analytics on the designated Reports server using the process described in the OBIEE 
installation documentation, located in the Oracle Fusion Middleware Online Documentation Library.

The Analytics installation copies an RPD (repository definition) file and a catalog that defines the Oracle 
Knowledge project, including the dashboards and reports.

After you install OBIEE, you must complete the following additional tasks to configure the Oracle Knowledge 
Analytics reporting components. 

Perform the following tasks:

• Reset the RPD (repository) password 

• Configure the connection between OBIEE and the data warehouse

• Deploy the RPD and catalog to create the Oracle Knowledge Analytics project within OBIEE

• Validate your installation
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Connect OBIEE to the Data Warehouse
Connect the OBIEE instance to the data warehouse by editing the database connection parameters in the RPD 
(repository) file that was installed as part of the Analytics installation process. 

The following procedures describe how to edit the RPD file using the OBIEE Admin Tool. This tool only runs on 
the Windows platform. For information on installing and using the OBIEE Administrator tool, see the 
documentation located here:

http://docs.oracle.com/cd/E29597_01/fusionapps.1111/e38322/appe_installbiadmin.htm

Important!   If you are using an SQL Server database, you must use Microsoft Data Access Components 
(MDAC), also known as Windows DAC, to define the ODBC data source and add and configure the 
appropriate driver. See http://msdn.microsoft.com/en-us/library/windows/desktop/
ms692872%28v=vs.85%29.aspx for MDAC documentation resources.

Note:   Copy the Analytics OBIEE components to a temporary directory on the Windows machine where the 
BI Administration Tool is installed. 

Open the RPD

Open the RPD file to configure it for your installation. Execute this task on a Windows machine using the 
OBIEE BI Administration Tool.

1 Open the Oracle BI Administration Tool.

2 Select File > Open > Offline.

3 Select the Oracle Knowledge Analytics RPD file.

4 Enter the default password: password85.

Change the RPD Password

The RPD file is shipped with a default password. We strongly recommend that you change the default 
password to make sure you deploy the RPD and Catalog.

To change the RPD password:

1 Select File > Change Password.

2 Enter the default password: password85.

3 Enter the new password and confirm it.

The repository password must be at least eight characters, with at least one numeric character. The 
New Password field cannot be empty.

Save the RPD

Use this procedure to save the RPD.

1 Select File > Save.

2 Close the OBI Administration Tool.
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Configuring Connections to the Database

The next step is to configure the OBIEE connection to the data warehouse. This requires the creation of 
System ODBC data sources using the Windows Control Panel. 

Use the following procedures to set the data source, set the reporting schema password, and check the 
connection to the reporting schema

CONFIGURING SQL SERVER CONNECTIONS

When configuring the RPD to a SQL Server database, perform these steps to change the connection pool 
information:

1 Open the RPD using the OBI Admin tool.

2 Navigate to the Physical Layer.

3 Right-click on the Oracle Data Warehouse 

4 Select Properties.

The Properties window appears.

5 Select the General tab.

6 Under Data source definition, set the database to SQL Server 2005. 

7 Select Query DBMS.

8 Select any connection in the Features tab.

9 Select OK & Save.

CONNECTING TO THE REPORTING SCHEMA

To set the database connection properties:

1 In the OBI Administration Tool, Physical pane, select Oracle Data Warehouse > Oracle Data 
Warehouse Connection Pool.

2 Enter the ODBC data source name for the DW_REPORTING schema.

3 Enter the password for schema DW_REPORTING under Shared Logon.

4 Repeat for Oracle Data Warehouse > Oracle Data Warehouse Repository Initblocks Connection Pool.

To check the connection:

5 Select Oracle Data Warehouse > DW_REPORTING > DIM_REPOSITORY, and then select View Data.

6 Select Oracle Data Warehouse Connection Pool, then select Select, then select OK.

If no data has been propagated from the staging schema to the reporting schema, the test succeeds.

7 Repeat this test, but select Oracle Data Warehouse Repository Initblocks Connection Pool instead of 
Oracle Data Warehouse Connection Pool.

Deploy the RPD and Catalog

The RPD and catalog define the Oracle Knowledge Analytics project, including the dashboards and reports, 
that you access using the OBIEE user interface.
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To deploy the catalog:

1 Navigate to OBIEE Enterprise Manager at http://<hostname>:7001/em, where <hostname> is the 
name of the server where OBIEE is installed.

2 Log in with the user name and password you used to install OBIEE.

3 On the left pane, select Business Intelligence/coreapplication.

4 On the right pane, select Lock and Edit Configuration. This prevents anyone else from making 
configuration changes at the same time. Wait for confirmation popup.

5 On the right pane, select Deployment/Repository.

6 Select Upload BI Server Repository > Choose File, and select the edited RPD file.

7 Copy the analyticsReportingModel85V2 folder to the catalog directory at: 
<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentationSe
rvicesComponent\coreapplication_obips1\catalog 

8 At BI Presentation Catalog, change the catalog location to $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/$COMPONENT_NAME/catalog/
analyticsReportingModel85V2.

9 Enter the Repository password.

10 Select Apply.

11 Select Activate Changes.

12 Select Restart to Apply Recent Changes.

13 Select Restart.

The RPD is deployed and the catalog that defines the Oracle Knowledge Analytics project within OBIEE is 
added.
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Apply the Analytics Styles to the OBIEE User Interface
Analytics requires a specific set of styles and formats to display the reports as they are designed to be viewed. 
You must configure OBIEE to use the Analytics style information. You configure and deploy the Analytics styles 
by:

• copying the style directories from the installation location to the deployment location (designated in the 
installation step Choose the OBIEE Components Location)

• installing and deploying the styles on the application server

• making the styles available to OBIEE

• activating and validating the configuration

Copy the Analytics Style Directories to the Deployment Location
The Analytics style directories contain the style and formatting information required for viewing Analytics 
reports on OBIEE. The Analytics installation process creates the following style directories at the location that 
you specify in the Choosing the OBIEE Components Location section of the Installation Guide:

• S_OracleKnowledge

• SK_OracleKnowledge

To add the Analytics style information to OBIEE, copy these directories to the following location in the OBIEE 
instance:

<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentationSer-
vicesComponent\coreapplication_obips1\analyticsRes

Install and Deploy the Analytics Styles
You install and deploy the Analytics styles by installing them as an application within WebLogic Server, using 
the WebLogic Administration Console. 

To install and deploy the styles:

1 Start the WebLogic Server Administration Console at the following URL:
http://<localhost>:7001/console

2 Select Deployments in the Domain Structure pane.

WebLogic Server displays the Summary of Deployments page.

3 Select Lock and Edit in the Change Center

4 Select the Install button.

WebLogic Server displays the Install Application Assistant page.

5 Specify the path to the location of the S_OracleKnowledge folder using the following fields:

Path: Specify the path to the parent of the AnalyticsRes directory where you copied 
the S_OracleKnowledge and SK_OracleKnowledge directories, for example: 
<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\Orac
leBIPresentationServicesComponent\coreapplication_obips1

Current Location: Ensure that the server name and the specified path are correct.
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The Install Application Assistant displays a list of eligible subdirectories.

6 Select the AnalyticsRes directory, which contains the S_OracleKnowledge and 
SK_OracleKnowledge directories.

7 Select Next to continue.

The Install Application Assistant prompts you to choose the targeting style.

8 Select Install this deployment as an application.

9 Select Next to continue.

If you have server clusters defined in your environment, the Install Application Assistant prompts 
you to choose a deployment target.

10 Select the appropriate server in the Clusters section.

Important!   In single-server environments, the Install Application Assistant does not display the 
Clusters section; you do not need to select a server. 

11 Continue the installation process by accepting the defaults on the subsequent screens until the Install 
Application Assistant displays the following option: 

I will make the deployment accessible from the following location

12 Select this option, and ensure that the Location field displays the correct path: 

<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentationSe
rvicesComponent\coreapplication_obips1\analyticsRes 

13 Select Finish.

The Install Application Assistant displays the deployed application, which starts with the status OK.

Make the Analytics Styles Available to OBIEE
You must make the styles that you have deployed available to the OBIEE presentation server by editing the 
OBIEE configuration. 

To edit the OBIEE configuration:

1 Edit the InstanceConfig.xml file at the following location:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServices
Component\coreapplication_obips1

2 Add the following markup to the InstanceConfig.xml file:

Important!   You must place the <URL> and <UI> markup with the <ServerInstance> and 
<WebConfig> tags.

<URL>
<CustomerResourcePhysicalPath><OBIEE_INSTALL_DIR>\instances\instance1\bifoundati
on\OracleBIPresentationServicesComponent\coreapplication_obips1\analyticsRes</
CustomerResourcePhysicalPath> 
<CustomerResourceVirtualPath>/analyticsRes</CustomerResourceVirtualPath>

</URL>
<UI>

<DefaultStyle>OracleKnowledge</DefaultStyle> 
<DefaultSkin>OracleKnowledge</DefaultSkin>

</UI>
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Save and Activate the Configuration
You must save and activate the new configuration by saving your WebLogic Server configuration changes and 
restarting the application in Enterprise Manager. 

To save your WebLogic Server configuration changes:

1 Select Activate Changes in the Change Center

To restart the application:

a Start Enterprise Manager at the following URL:

http://<localhost>:7001/em

b Select Business Intelligence from the hierarchy in the left pane, then select coreapplication.

Enterprise Manager displays the coreapplication Overview tab.

c Select Restart under Manage System in the System Shutdown and Startup section.

Linking to Information Manager Articles from Analytics Reports
You can configure Analytics so that the user interface displays article IDs in reports as links.

When users select the article ID, a configured instance of Information Center displays the article in preview 
mode. See the Analytics Administration Guide, “Enabling Links to Information Manager Articles from Analytics 
Reports” section for more information. It is located here:.

Validating the OBIEE Installation
Until the first set of data transforms occurs, you cannot validate the report installation. You can verify the RPD 
connection to the database by opening the RPD in online mode and browsing the data directly in the RPD. 
There wont be any data in most of the tables but you should be able to connect and see data in the DIM_DATE 
table.

You can log onto the OBIEE reporting user interface to validate the installation and configuration process. You 
can validate the installation process by logging onto the application at: http://<hostname>:7001/analytics using 
the credentials you specified during installation.

The Oracle Knowledge Analytics Home Page displays the preconfigured dashboards. You can open one, such 
as Search Analysis, to validate the installation. You can now perform other administrative tasks, as described 
in the Oracle Knowledge Analytics Administration Guide.
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Manage the JMS Event Router for Analytics
You manage the Analytics Event Router using the processes described in this section.

Manage the Analytics Event Router from the WebLogic Admin 
Console 
Start the Analytics Event Router by starting the specified managed server through the WebLogic 
Administration Console.

Start managed servers through the WebLogic Administration Console by using the WebLogic Server node 
manager. Make sure the node manager is running.

Note:   If the Node Manager service was not installed as part of the WebLogic Server installation, you can 
install it as a service on Windows. Follow the instructions for installing and uninstalling the Node Manager 
Service in the post-installation section of the Oracle Fusion Middleware Installation Guide for Oracle 
WebLogic Server 11g.

If you do not want the node manager running as a service on Windows, or you are using Linux, start the Node 
Manager manually.

To start the Node Manager service manually:

1 Open a command prompt.

2 Navigate to the <weblogic_dir>/Middleware/wlserver_10.3/server/bin directory, where 
<weblogic_dir> is the installation directory of your WebLogic Server.

3 On Linux, execute startNodeManager.sh. On Windows, execute startNodeManager.cmd.

4 The node manager continues running in the command prompt.

To start or stop the managed server from the WebLogic Administration Console:

5 Start the Administration Server (if it is not running).

6 Using a Web browser, navigate to the WebLogic Administration Console URL. (This can be found at 
http://<Administration Server Listen Address>:<Administration Server Listen 
Port>/console.)

7 Provide the Administration Server's credentials to log in.

8 From the Domain Structure section, expand the Environment.

9 Select Servers to manage and control the Managed Server.

10 Select the Control tab to start and stop the Managed Server.

11 Select the check box of the Managed Server specified in the installation process.

12 Select Start or Shutdown/Force Shutdown Now.

The State of the server now reflects that the server is STARTING or FORCE_SUSPENDING.

13 Select the Refresh icon above the table of servers. 

When the State of the server shows that the server is running, you can access the Analytics Event 
Router application. 
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When the State shows SHUTDOWN, the server must be restarted to access the Analytics Event 
Router application.

Install the Analytics Event Router Service (Windows)
To install the Analytics Event Router Service on Windows:

1 Open a command prompt and cd into $Oracle_Knowledge_Analytics_ROOT/instances/
<Instance_Name> where <Instance_Name> refers to the Analytics Event Router instance name 
on this installation. Execute setenv.bat to open the Common Environment.

2 Install the Analytics Event Router service by executing the following command in the Common 
Environment:

inquiraanservice -installUninstall the Analytics Event Router service by executing the 
following command in the Common Environment:

inquiraanservice -uninstall

Manage the Analytics Event Router from the Common Environment
You manage the Analytics application using the following Common Environment commands.

Open a command prompt and cd into $Oracle_Knowledge_ROOT/instances/<Instance_Name>, 
where <Instance_Name> refers to the Analytics Event Router instance name on this installation. Execute 
setenv.sh on Linux or setenv.bat on Windows to open the Common Environment.

Note:   The commands inquiraan.sh/inquiraan restart and inquiraan.sh/inquiraan stop 
can only be executed successfully when the application is started by executing the inquiraan.sh start 
and inquiraan start commands.

Command Description

• inquiraan.sh start (Linux)
• inquiraan start (Windows)

Starts the Analytics Event Router service

• inquiraan.sh stop (Linux)
• inquiraan stop (Windows)

Stops the Analytics Event Router service 

• inquiraan.sh restart (Linux)
• inquiraan restart (Windows)

Stops and restarts the Analytics Event Router service
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CHAPTER 7

Installing AnswerFlow 

This section describes the process of installing Oracle Knowledge AnswerFlow. AnswerFlow provides 
automated guidance that allows agents to increase their productivity and improve service quality. It leverages 
contextual data and external systems to apply diagnostics and resolve complex service processes with 
guided knowledge delivery. 

This section explains:

• Installation Requirements

• Configuring Information Manager

• Running the AnswerFlow Installer

• Completing the Installation

Installation Requirements
Before running the AnswerFlow installation program:

• Create a dedicated AnswerFlow repository in Information Manager. You will need the Repository 
Reference Key of this repository during the AnswerFlow installation process.

• Ensure that Oracle WebLogic Server is installed, and the Node Manager and Admin Servers are running 

• Ensure than you have configured an Oracle WebLogic Server domain. 

Important!   Activate any changes to the WebLogic Server domain. The domain cannot be in edit 
mode while the installer is running.

• Note the Information Manager Web Services URL, the Information Manager Resources URL, and the 
Information Manager Console URL for the instance of Information Manager that you are configuring 
AnswerFlow with; you will need to supply these values during installation.

Configuring Information Manager
Before you install AnswerFlow, configure the following Information Manager functions.

Creating and Assigning Categories
For a category to be visible to a user in AnswerFlow Editor or AnswerFlow SampleUI, the category must be 
assigned to the AnswerFlow channel, and the category or a category above it hierarchically must be assigned 
to the user.
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1 Create a Repository in the Information Manager instance. Name the repository AnswerFlow and 
point it to AnswerFlow in Schema Properties

2 In the Information Manager Console, go to Repository, then Categories. Create Categories and 
Subcategories for the Object Library used to navigate AnswerFlow processes and objects. 

For information on creating categories and subcategories, see “Adding a Content Category” in the 
Oracle Knowledge Information Manager Administration Guide.

3 In the Information Manager Console, go to Users, then Console Users, and then List.

4 Click the name of the user to assign Management Console User Properties.

5 Click Edit User to access the User details page.

6 In the Categories section, from the Available Categories, move to the Selected Categories each 
category that you want to assign to the user.

For information on creating users, see “Management Console User Properties” in Oracle Knowledge 
Information Manager Administration Guide.

7 In the Information Manager Management Console, assign categories to users.

8 In the Repository tab in Information Manager, AnswerFlow screen Development Data Schema 
Properties, create the AnswerFlow Channel. 

Creating an AnswerFlow Channel
The Information Manager channel that you create is used to determine the Information Manager categories 
for AnswerFlow objects, and to store the promoted top-level process documents.

Note:   The AnswerFlow installation process prompts you for the channel reference key.

To create a channel:

1 In the repository where you plan to promote the AnswerFlow data, create a channel and give it a 
unique name.

The Information Manger channel that you create is used to determine the Information Manager 
categories for AnswerFlow objects, and to store the promoted top-level process documents.

2 In Category Options, move the relevant categories from Available Categories to Selected Categories.

Note:   The categories are navigation filters.

3 In the channel that you created, create the schema, create the node (System Data), and all the 
attributes beneath the node as shown in the following table.

Important!   Do not change the System Data node and its attributes; name and define the node 
and its attributes only as noted in the following table. It is critical to name the attributes as shown and 
confirm that the reference keys are as specified.

Nodes and Attributes Field Type Reference Key

-Root

--System Data non-repeating node SYSTEM_DATA

---Process Name *MT - Text Field PROCESS_NAME

---Process Version *T - Integer PROCESS_VERSION

---Process ID *T – Text Field PROCESS_ID
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* - Required Field; M - Master Identifier; T - Included in full text search; A - Available in attribute search

Note:   You may add other nodes to the root element, as long as you specify the System Data node and its 
attributes as listed above.

Running the AnswerFlow Installer
Start the installer by locating and executing the appropriate version of the installer for your environment.

Starting the Installer in Windows Environments
On Windows 2008, the user must be part of the Administrators group to install and operate Oracle Knowledge 
products.

To start the installer in Windows environments:

Double-click the installation file: 

– or –

Run the file using the command line with the following command:

install_answerflow_<app_server>_<operating_system>_build_<#>.exe

Starting the Installer in Linux Environments
On Linux, Oracle Knowledge software must be installed using a non-root user. Before running the installer, 
create a standard Oracle Knowledge admin (Linux) user in the operating system. This user installs and runs the 
Oracle Knowledge software and must be given permission to access network shares while running as a service.

To start the installer in Linux environments:

1 Open a bash shell by entering bash command: 

bash

2 Use cd to go to the installer temporary directory.

3 Set the default locale for the bash shell to en_US by entering the following:

export LC_ALL="en_US"

---Promotion ID *T - Text Field PROMOTION_ID

---Tags TA - Text Field TAGS

---Submission Notes *T - Text Area SUBMISSION_NOTES

---Submitted By *TA - Text Field SUBMITTED_BY

---Submission Date *A - Date/Time SUBMISSION_DATE

---Preview URL * - Text Field PREVIEW_URL

---View Detail URL * - Text Field VIEW_DETAIL_URL

---Promotion URL * - Text Field PROMOTION_URL

---Compiled Data Text Area COMPILED_DATA

---Compiled Data Format *T - Text Field COMPILED_DATA_FORMAT

Nodes and Attributes Field Type Reference Key
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4 Set permissions on the binary files so that they are executable by entering:

chmod +x *.bin

5 Start the installer:

./install_answerflow_<app_server>_<operating_system>_build_<#>.bin

When the initialization progress dialog completes, the installer displays the introduction screen. The 
Installation Introduction screen recommends that all other programs running be stopped and provides 
information on operating the installer.

6 Select Next to continue.

The Choose Install Folder screen opens.
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Choosing the Installation Folder
Select the directory location where you want to install AnswerFlow. You install AnswerFlow within an instance 
of Information Manager. You have the option to choose the default, recommended installation directory:

• Linux: home/<user_name>/Oracle/Knowledge/AnswerFlow

• Windows: C:\Oracle\Knowledge\AnswerFlow

Although you can install at any location, the recommended location is the base Oracle Knowledge 
application directory.

2

1 Select Choose to open a file browser and select an alternate Oracle Knowledge base directory. 

Use the Restore Default Folder option to reset the default installation directory, if necessary.

2 Select Next to continue.

The Choose Keystore Location screen opens.
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Setting the Keystore Location
Specify the location of the Oracle Knowledge keystore. 

Important!   If you have created a keystore while installing another Oracle Knowledge product, use the 
keystore created during that installation by selecting its location.

For more information about the keystore, see “Creating the Oracle Knowledge Keystore” on page 24.

1 Specify the location of an existing Keystore.

2 Select Next to continue.

The Confirm Database Creation screen opens.
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Confirming Database Creation
Choose to either create a new database or to connect to an existing database. You configure AnswerFlow to 
use an existing Information Manager database, or to use a separate dedicated database. You can configure 
AnswerFlow to use any database that Oracle Knowledge supports.

1 In the Confirm DB Creation? window, select either: 

• To create a new database, click Yes.

• To connect to an existing database, click No.

2 Click Next to continue.

The Select Database Type screen opens.
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Selecting the Database Type
Choose the type of database that you will create or connect to. 

1 In the Select Database Type window, select the type of database from the drop-down list.

2 Click Next to continue.

The Set Database Parameters screen opens.
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Setting the Database Parameters
Enter credentials for the AnswerFlow database and DataSource Name.

1 In the Set Database Parameters window, enter the required information about the AnswerFlow 
database and DataSource Name.

2 Select Next to continue.

The Choose the Java Home Directory screen opens.
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Choosing the Java Home Directory
Specify the parent directory of the bin directory for the JDK used by Oracle WebLogic Server. For example, 
C:\Oracle\Middleware\jdk170_71 on Windows or usr/lib/jvm/jdk170_71 on Linux. This must be 
the same JAVA_HOME directory used by the Oracle WebLogic Server.

1 In the Choose the WebLogic Java Home Directory window, select the parent directory of the JDK’s bin 
directory.

2 Click Next to continue.

The Choose WebLogic Middleware Installation Directory screen opens.
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Choosing the WebLogic Middleware Installation Directory
Select the WebLogic middleware home directory:

1 In the Please Choose a Folder field, choose the middleware home directory for WebLogic.

2 Click Next to continue.

The Choose the WebLogic Server Install Directory screen opens.
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Choosing the Oracle WebLogic Server Installation Directory
Select the directory in which Oracle WebLogic Server is installed:

1 In the Please Choose a Folder field, choose the installation directory of the WebLogic server, for 
example, C:\Oracle\Middleware\wlserver_10.3.

2 Select Next to continue.

An Information window opens, showing the WebLogic Server Details.

3 Click OK.

The Choose a WebLogic Domain screen opens.
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Choosing an Oracle WebLogic Server Domain
Specify the details of an Oracle WebLogic server domain:

1 Specify the name and location of the Oracle WebLogic Server domain where you will install the Oracle 
Knowledge Applications.

2 Select Next to continue.

The Set Oracle WebLogic Server Administrator Credentials screen opens.
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Setting Oracle WebLogic Server Administrator Credentials
Provide the administrator credentials for the server of the specified domain.

1 Provide the following credentials:
.

2 Select Next to continue.

The Confirm Installation screen opens.

Property Description 

Administrator User Name Specify the user name of the user used to boot the administration server.

Administrator User Password Specify the password of the user used to boot the administration server.

Administration Server URL Specify the <protocol>://<listen address>:<listen port> 
used to connect to the administration server. For example, t3://
localhost:7001.
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Installing Editor and Runtime
In the Confirm Installation screen, select whether or not to install AnswerFlow Editor and Runtime.

1 To install Editor, select the Editor check box.

2 To install Runtime, select the Runtime check box.

3 Click Next to continue.

The Managed Server for Editor Webapp screen opens.
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Configuring the AnswerFlow Editor Managed Server (Oracle 
WebLogic Server)
To configure the AnswerFlow Editor managed server, you will do the following procedures:

• Selecting or Creating the AnswerFlow Editor Web Application Managed Server

• Setting Values for Editor Managed Server (New) or Setting Values for Editor Managed Server 
(Existing)

• Setting Java Options for Editor Web Application Server

Selecting or Creating the AnswerFlow Editor Web Application Managed Server

Select whether to create a new managed server or use an existing managed server for the AnswerFlow 
Editor web application.

1 To create a new managed server for the AnswerFlow Editor webapp, select Yes. To deploy 
AnswerFlow Editor to an existing managed server, select No.

The Set Editor Managed Server Values screen opens.

Setting Values for Editor Managed Server (New)

If you have selected to create a new managed server for the Editor web application, the installation program 
uses the credentials of the administration server to boot the new managed server. The new managed server 
must be associated with a machine. The installation process can create a new machine or you can provide 
the name of an existing machine in your domain.
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s 

 

 if 
1 Specify the following properties:

2 Select Next to continue.

The Java Options for Editor Webapp’s Server screen opens.

Property Description 

Managed Server Name Specify the name of the new managed server. Ensure that the name is unique to your 
domain.

Listen Address Specify the listen address of the new managed server. The default value is the local addres
of the machine running the installation program.

Listen Port Specify the listen port of the new managed server. The default value is 8232.

Machine Name Specify the name of the machine in the domain that the new managed server is associated
with. If this is a new machine, ensure that the name is unique to your domain.

Editor URL (or 
AnswerFlowEditorURL if 
you are installing with the 
Tomcat application server)

Enter the URL in the format: http://<hostname>:8232

The installer’s default format for this field is incorrect; ensure that you do not include the 
qualifier /AnswerFlowEditor

Is this an existing machine 
in your domain?

Select Yes if you are providing the name of an existing machine in your domain. Select No
you want the installation program to create a new machine with this name.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



188 CONFIGURING THE ANSWERFLOW EDITOR MANAGED SERVER (ORACLE WEBLOGIC SERVER)
Setting Values for Editor Managed Server (Existing)

If you have selected to provide an existing managed server for the Editor web application, the installation 
program uses the credentials provided to boot the managed server. 

If credentials for the managed server are not set, leave the User Name and User Password fields blank and 
the credentials of the administration server are used to boot the managed server.

1 Specify the following properties:

2 Select Next to continue.

The Java Options for Editor Webapp’s Server screen opens.

Property Description 

Managed Server Name Specify the name of the existing managed server.

Listen Address Specify the listen address of the existing managed server.

Listen Port Specify the listen port of the existing managed server.

User Name Specify the user name of the user used to boot this managed server.

User Password Specify the password of the user used to boot this managed server.
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Setting Java Options for Editor Web Application Server

Specify the Java memory options used to start the Editor web application server.

1 Specify the following Java memory options:

2 Select Next to continue.

The Managed Server for RuntimeUI Webapp screen opens.

Property Description 

Memory Allocation Pool Initial Size The initial and minimum Java heap size in megabytes.

Memory Allocation Pool Maximum Size The maximum Java heap size in megabytes.

Maximum Permanent Generation Size The maximum size for the permanent generation heap in megabytes.
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Configuring the RuntimeUI Managed Server (Oracle WebLogic 
Server)
Configuring the RuntimeUI managed server consists of the following procedures:

• Selecting or Creating the RuntimeUI Web Application Managed Server

• Setting Values for RuntimeUI Managed Server (New) or Setting Values for RuntimeUI Managed 
Server (Existing)

• Setting Java Options for the RuntimeUI Web Application Server

Selecting or Creating the RuntimeUI Web Application Managed Server

Select whether you want to create a new managed server or use an existing managed server for the 
AnswerFlow RuntimeUI web application. This server should be different from the server that contains the 
AnswerFlow Editor web application.

• To create a new managed server for the AnswerFlow RuntimeUI web application, click Yes. 

The Set RuntimeUI Managed Server Values screen opens when you click Next.

• To deploy AnswerFlow RuntimeUI to an existing managed server, click No. 

The Set RuntimeUI Managed Server Values opens when you click Next.
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Setting Values for RuntimeUI Managed Server (New)

If you have selected to create a new managed server for the RuntimeUI web application, the installation 
program uses the credentials of the administration server to boot the new managed server. The new 
managed server must be associated with a machine. The installation process can create a new machine or 
you can provide the name of an existing machine in your domain.

1 Specify the following properties:

2 Click Next to continue.

The Java Options for RuntimeUI Webapp’s Server screen opens.

Property Description 

Managed Server Name Specify the name of the new managed server. Ensure that the name is unique to your 
domain.

Listen Address Specify the listen address of the new managed server. The default value is the local 
address of the machine running the installation program.

Listen Port Specify the listen port of the new managed server. The default value is 8233.

Machine Name Specify the name of the machine in the domain that the new managed server is 
associated with. If this is a new machine, ensure that the name is unique to your domain.

Is this an existing 
machine in your domain?

Select Yes if you are providing the name of an existing machine in your domain. Select 
No if you want the installation program to create a new machine with this name.
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Setting Values for RuntimeUI Managed Server (Existing)

If you have selected to provide an existing managed server for the RuntimeUI web application, the installation 
program uses the credentials provided to boot the managed server. If credentials for the managed server are 
not set, leave the User Name and User Password fields blank and the credentials of the administration 
server are used to boot the managed server. Please note that you should not use the same managed server 
that you used for Editor.

1 Specify the following properties:

2 Select Next to continue.

The Java Options for RuntimeUI Webapp’s Server screen opens.

Property Description 

Managed Server Name Specify the name of the existing managed server.

Listen Address Specify the listen address of the existing managed server.

Listen Port Specify the listen port of the existing managed server.

User Name Specify the user name of the user used to boot this managed server.

User Password Specify the password of the user used to boot this managed server.
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Setting Java Options for the RuntimeUI Web Application Server

Specify the Java memory options used to start the RuntimeUI web application server.

1 Specify the following Java memory options:

2 Select Next to continue.

The Get Information Manager Connection Parameters screen opens.

Property Description 

Memory Allocation Pool Initial Size The initial and minimum Java heap size in megabytes.

Memory Allocation Pool Maximum Size The maximum Java heap size in megabytes.

Maximum Permanent Generation Size The maximum size for the permanent generation heap in megabytes.
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Providing Information Manager Connection Parameters
Provide the connection and repository details for your Information Manager installation. 

1 Provide the following Information Manager connection parameters:

2 Select Next to continue.

The Get SampleUI Credentials screen opens.

Parameter Description

Information Manager Web Services URL Information Manager Web Services URL for authentication and 
retrieving Information Manager documents

Information Manager Resources URL Resource URL for linking to files from Information Manager documents

Repository Reference Key This should be the Information Manager repository containing the 
Information Manager documents that are used with AnswerFlow.
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Providing SampleUI Credentials
Provide the credentials that the SampleUI webapp uses to retrieve Information Manager documents. The 
repository reference key used by the SampleUI webapp to retrieve Information Manager documents should 
be the same as the one entered in the previous screen since AnswerFlowEditor and SampleUI always use 
the same IMWS and Information Manager resource URLs.

1 Provide the following Information Manager connection parameters:

2 Select Next to continue.

The Select Activate Analytics Logging screen opens.

Parameter Description

Username Enter the username for the SampleUI to use to connect to the Information Manager 
repository.

Password Enter and confirm the password associated with the username above.

Repository Reference Key This should be the Information Manager repository containing the Information 
Manager documents that are used with AnswerFlow.
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Activating Analytics Logging
Choose whether or not to activate Oracle Knowledge Analytics logging.

1 Select Yes to log Analytics or No to not log Analytics.

2 Click Next to continue.

The Pre-Installation Summary screen opens.
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Pre-Installation Summary
The Pre-Installation Summary screen displays a summary of your installation selections, as well as disk 
space information, prior to transferring the product files from the distribution.

1 Review your selections.

2 To make any corrections, select Previous.

3 Select Install to continue.

AnswerFlow beings installing in the specified location.

When the AnswerFlow installation is complete, the Installation Complete screen opens.

4 Make note of the access URL. The default is http://localhost:8232/AnswerFlowEditor

5 Select Done to exit the installation program.

After completing the installation, you can start the application as described in “Deploying the 
xmemcached Archive” on page 200.
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Completing the Installation
Perform the following configuration to complete the AnswerFlow installation.

Installing the AnswerFlow Service (Windows)
When you install and configure Oracle Knowledge and AnswerFlow, the installer places ICE items in the 
Windows Start menu for each defined instance if product icons were selected to be installed.

To install the AnswerFlow service on Windows:

1 Select the ICE item for the desired instance:

Start > Programs >Oracle > Knowledge > <application_name> (default) Environment

a If no product icons were installed, open a command prompt and cd into 
<Oracle_Knowledge_home>/instances/<Instance_Name>  
where <Instance_Name> refers to the AnswerFlow instance name on this installation. 

b Execute setenv.bat to open the ICE command prompt.

2 Install the AnswerFlow service by executing the following command in the ICE:

inquiraafservice.bat -install or inquiraafservice -install.

Optionally, to uninstall, use the command:

inquiraafservice.bat -uninstall or inquiraafservice -uninstall.

Operating AnswerFlow from the Common Environment
Use the following commands to start and stop the AnswerFlow service from the Common Environment:

Note:   The commands inquiraaf.sh/inquiraaf restart and inquiraaf.sh/inquiraaf stop 
operate successfully only if the application was started by executing the inquiraaf.sh start or 
inquiraaf start commands.

You can use the Oracle WebLogic Server Administration Console to start the managed server as described in 
“Start Oracle Knowledge on WebLogic Server” on page 38.

You can also start AnswerFlow from the ICE environment.

Command Description

• inquiraaf.sh start (Linux)
• inquiraaf start (Windows)

Starts the Editor service when run from the Editor ICE 
window; starts the RuntimeUI service when run from the 
RuntimeUI ICE window.

• inquiraaf.sh stop (Linux)
• inquiraaf stop (Windows)

Stops the Editor service when run from the Editor ICE 
window; stops the RuntimeUI service when run from the 
RuntimeUI ICE window. 

• inquiraaf.sh restart (Linux)
• inquiraaf restart (Windows)

Stops and restarts the Editor service when run from the 
Editor ICE window; stops and restarts the RuntimeUI 
service when run from the RuntimeUI ICE window.
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To start AnswerFlow from the ICE prompt:

1 Open a command prompt and change to 

<Oracle Knowledge_home>/instances/<Instance_Name>

where 

<Instance_Name> is the AnswerFlow instance name on this installation.

2 On Linux, execute setenv.sh to open an ICE command prompt. 
On Windows, execute setenv.bat to open an ICE command prompt.

3 Execute the appropriate script from the ICE environment:

On Linux, execute inquiraaf.sh start. 

On Windows, execute inquiraaf start.

Restarting the AnswerFlow Service
You must restart the AnswerFlow service to apply any configuration changes to the AnswerFlow Web 
applications.

Important!   You must start the ICE environment as an administrator in order to install, uninstall, stop, or 
start Oracle Knowledge services.

Restarting AnswerFlow on Linux

To restart AnswerFlow service on Linux:

1 Open a command prompt and change to:

<Oracle_Knowledge_home>/instances/<Instance_Name> 

where 

<Instance_Name> is the AnswerFlow instance name on this installation.

2 Execute setenv.sh to open an ICE command prompt.

3 Restart the AnswerFlow instance by executing the following command in the ICE command prompt:

inquiraaf.sh restart

Restarting AnswerFlow on Windows

When you install and configure Oracle Knowledge and AnswerFlow, the installer places Common 
Environment items in the Windows Start menu for each defined instance if product icons were selected to be 
installed.

To restart the AnswerFlow service on Windows:

1 Select the ICE item for the desired instance:

Start > Programs > Oracle > Knowledge > <application_name> (default) Environment

If you did not install product icons, open a command prompt and change to:

<Oracle_Knowledge_home>/instances/<Instance_Name> 

where:

<Instance_Name> is the AnswerFlow instance name on this installation.
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2 Execute setenv.bat to open an ICE command prompt.

3 Restart the AnswerFlow instance by executing the following command in the ICE command prompt:

inquiraaf restart

Deploying the xmemcached Archive
You must deploy the xmemcached jar to enable certain AnswerFlow functions.

For Tomcat, deploy the file xmemcached-1.4.1.jar as follows:

1 Download the file https://xmemcached.googlecode.com/files/xmemcached-1.4.1.jar

2 Copy the file xmemcached-1.4.1.jar to <AnswerFlow installation directory>/
instances/Editor/appserveraf/webapps/AnswerFlowEditor/WEB-INF/lib

3 Copy xmemcached-1.4.1.jar to <AnswerFlow installation directory>/Sample/
SampleUI/lib

For WebLogic, deploy the file xmemcached-1.4.1.jar as follows:

1 Download the file https://xmemcached.googlecode.com/files/xmemcached-1.4.1.jar

2 Copy the file xmemcached-1.4.1.jar to <AnswerFlow installation directory>/
instances/Editor/webapps/AnswerFlowEditor/WEB-INF/lib

3 Copy xmemcached-1.4.1.jar to <AnswerFlow installation directory>/Sample/
SampleUI/lib

Compiling and Deploying the SampleUI Web Application
If you are planning to use the RuntimeUI, you must compile and deploy the SampleUI web application:

1 Start the RuntimeUI ICE if it is not running.

a Change directory to <AnswerFlow installation directory>/instances/RuntimeUI/

b execute setenv.sh for Linux/Solaris or setenv.bat for Windows

2 If you are using WebLogic and the WebLogic Admin Server for the domain in which you installed 
AnswerFlow is not running, start it now.

3 For Linux or Solaris, run deploy.sh -s <location of SampleUI source directory> -w 
<location of SampleUI.war>. For example, deploy.sh -s ../../Sample/SampleUI -w ../../Sample/
SampleUI/target/SampleUI.war

For Windows, run deploy.bat -s <location of SampleUI source directory> -w 
<location of SampleUI.war>. For example, deploy.bat -s ../../Sample/SampleUI -w 
../../Sample/SampleUI/target/SampleUI.war
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CHAPTER 8

Installing RightNow Integration 
Components

This chapter describes the installation process for Oracle Knowledge RightNow integration components.

Oracle Knowledge RightNow Integration Overview
The Oracle Knowledge RightNow integration package provides the necessary components to integrate 
Oracle Knowledge content with RightNow Agent Desktop and Customer Portal. The installer places the 
integration components into the directory you specify. This installer does not install RightNow Agent Desktop 
and Customer Portal. You must install those separately using the installers available from Oracle.

Note:   RightNow Agent Desktop and Customer Portal are available only on the Windows platform.

Run the Oracle Knowledge RightNow Installer
You start the RightNow installer by following the appropriate steps for your environment.

Starting the Installer in Windows Environments
On Windows 2008, the user must be part of the Administrators group to install and operate Oracle Knowledge 
products.

To start the installer in Windows environments:

Double-click the installation file

– or –

Run the file using the command line with the following command:

install_okrightnow_<operating_system>_build_<#>.exe

Starting the Installer in Linux Environments
On Linux, Oracle Knowledge software must be installed using a non-root user. Before running the installer, 
create a standard Oracle Knowledge admin (Linux) user in the operating system. This user installs and runs 
the Oracle Knowledge software and must be given permission to access network shares while running as a 
service.
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To start the installer in Linux environments:

1 Open a bash shell by entering bash command: 

bash

2 Use cd to go to the installer temporary directory.

3 Set the default locale for the bash shell to en_US by entering the following:

export LC_ALL="en_US"

4 Set permissions on the binary files so that they are executable by entering:

chmod +x *.bin

5 Start the installer:

./install_okrightnow_<operating_system>_build_<#>.bin

When the initialization progress dialog completes, the installer displays the introduction screen. The 
Installation Introduction screen recommends that all other programs running be stopped and provides 
information on operating the installer.
INSTALLING AND CONFIGURING ORACLE KNOWLEDGE



203 ORACLE KNOWLEDGE RIGHTNOW INSTALLATION INTRODUCTION
Oracle Knowledge RightNow Installation Introduction
The installer’s introduction screen provides general information about the installation process and 
recommends that you close any other programs that are currently running.

Select Next to continue.

The installer displays the Configure RightNow Location screen.
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Configure RightNow Location
Select the directory location where you want the Oracle Knowledge Right Now Integration Artifacts to be 
installed.

The installer displays the default, recommended installation directory:

• home/<user_name>/Oracle/Knowledge/archive/RightNow on Linux

• C:\Oracle\Knowledge\archive\RightNow on Windows

You can install at any location. The recommended location is within the base Oracle Knowledge application 
directory (for example: home/<user_name>/Oracle/Knowledge or C:\Oracle\Knowledge).

Select Choose to open a file browser and select an alternate Oracle Knowledge base directory.

Use the Restore Default Folder option to reset the default installation directory, if necessary.

Select Next to continue.

The installer displays the Pre-Installation Summary screen.
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Pre-Installation Summary
The Pre-Installation Summary screen displays a summary of your installation selections prior to transferring 
the product files from the distribution.

Review your selection.

Select Previous to make any corrections.

Select Install to continue.

The installer begins installing the Oracle Knowledge RightNow Integration Artifacts in the specified location.

When the Oracle Knowledge RightNow installation completes, the installer presents the Installation 
Complete screen.
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Installation Complete
Make note of the installation directory.

Select Done to exit the installation program.

After completing the installation, you can find the artifacts in the specified location.

Post-Installation Instructions
Use the instructions in the Oracle Knowledge for RightNow Integration Guide to configure the installed 
components and complete the integration.
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CHAPTER 9

Troubleshooting Oracle 
Knowledge Installations 

This appendix describes troubleshooting procedures for Oracle Knowledge installations in the following 
sections:

• Import the Analytics ODI Components Manually

• Uninstall Oracle Knowledge

Import the Analytics ODI Components Manually
To manually import the Analytics ODI components:

1 Open ODI Studio and connect to the desired work repository.

2 For all of the following imports, use these parameters:

• Import Mode: Synonym Mode INSERT_UPDATE.

• Select Import From a Folder.

• Select the directory of the ODI component (master, logical, or work).

3 In the Topology tab, select Import, then select Import the Master Repository.
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4 Select the master directory, and use the parameters identified in step 2.

5 Select OK.

6 In the Topology tab, select Import, then select Import the Logical Topology.

7 Select the logical directory, and use the parameters identified in step 2.

8 Select OK.

9 In the Designer tab, select Import, then select Import the Work Repository.

10 Select the work directory, and use the parameters identified in step 2.

11 Select OK.

Uninstall Oracle Knowledge
Oracle Knowledge provides uninstall programs for each component. 

The uninstall application is not supported on the following platforms:

• Oracle Linux operating on Oracle Exalogic processors

• Microsoft Windows Server 2012 R2 Enterprise

For instructions on removing Oracle Knowledge components from these platforms, see “Uninstall on Oracle 
Linux Operating on Oracle Exalogic Processors” on page 212 or “Uninstall on Microsoft Windows Server 
2012 R2 Enterprise” on page 212.

This section describes the following procedures:

• Uninstall Intelligent Search

• Uninstall Information Manager

• Uninstall AnswerFlow

• Uninstall on Oracle Linux Operating on Oracle Exalogic Processors

• Uninstall on Microsoft Windows Server 2012 R2 Enterprise

• Remove Oracle Knowledge WebLogic Components

Important!   You must stop all Oracle Knowledge services before you begin any of the uninstallation 
procedures.
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Note:   The Uninstaller screens are displayed only in the Uninstall Intelligent Search section below. The 
Uninstaller screens are similar for all other components; the individual procedures describe any significant 
differences.

Uninstall Intelligent Search
To uninstall Intelligent Search:

1 Locate the UninstallerData folder.

This folder is located at <Oracle_Knowledge_home>/UninstallerData.

2 Execute Uninstall_Inquira on Linux.

- or -

Execute Uninstall_Inquira.exe on Windows.

The Uninstall Oracle Knowledge screen displays.

3 Select Uninstall.
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The uninstall process begins:

The Uninstall Complete screen displays.

Files that were added after the installation are not removed as a part of the uninstallation process. 
These items appear in the The following items could not be removed field, and they must be 
removed manually. Review these files before deleting. Depending upon your operating system, some 
items may not appear on the screen.

4 On Windows, select either Yes, restart my system or No, I will restart my system myself.

5 Select Done.
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Uninstall Information Manager
To uninstall Information Manager:

1 Locate the UninstallerData folder.

This folder is located at <Oracle_Knowledge_home>/Uninstall_Information_Manager

2 Execute Uninstall_Information_Manager on Linux.

- or -

Execute Uninstall_Information_Manager.exe on Windows.

The Uninstall Oracle Knowledge screen displays.

3 Select Uninstall.

The uninstall process begins.

The uninstall process removes the Oracle Knowledge files.

The uninstall Complete screen displays.

4 Select Done.

Uninstall AnswerFlow
To uninstall Information Manager:

1 Locate the UninstallerData folder.

This folder is located at <Oracle_Knowledge_home>/Uninstall_AnswerFlow

2 Execute Uninstall_AnswerFlow on Linux.

- or -

Execute Uninstall_AnswerFlow.exe on Windows.

The AnswerFlow uninstallation program starts and the Introduction screen displays.

3 Select Next to continue.

The Choose Components to Uninstall screen appears.

4 Select the data you do not wish to delete during uninstallation. Your data is preserved by backing up 
files and folders according to the following table (the files and folders are moved from Source Path to 
Destination Path):

5 Select Next to continue.

The selected data is moved and the application components are removed.

The Uninstall Complete screen displays.

6 Select Done.

Option Source Path Destination Path 

Process Data <Install_Directory>\data\ 
Editor\SVN\Repositories\PM

<Install_Directory>\savedData\ 
SVNRepository

<Install_Directory>\data\ 
Editor\VERSION

<Install_Directory>\savedData\ 
VERSION

SampleUI Project <Install_Directory>\Sample 
\SampleUI

<Install_Directory>\SampleUI
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Uninstall on Oracle Linux Operating on Oracle Exalogic Processors 
After you have manually stopped all running Oracle Knowledge services, remove the installation by running 
the Linux command on all installed Oracle Knowledge instances:

rm -rf <InstallDir> 

Uninstall on Microsoft Windows Server 2012 R2 Enterprise
After you have manually stopped all running Oracle Knowledge services, you can then delete the services.

You must then manually delete the installation directories for all installed Oracle Knowledge instances.

Remove Oracle Knowledge WebLogic Components
There are three types of WebLogic components that can be uninstalled: Managed Servers, Machines, and 
Deployments. This section discusses how to remove them.

Begin the Removal Process

Before removing these components, please ensure that the Oracle WebLogic Administration Server is 
running and that you are logged into the Administration Console. Once the server is running and you are 
logged in, click the "Lock & Edit" button. This enables you to make changes to the administration server.

Remove Oracle Knowledge Components from WebLogic

Use the following procedures to remove managed servers, machines, and deployments from WebLogic.

MANAGED SERVERS

1 Navigate to Environment > Servers.

2 Select the checkboxes for the following:

• IntelligentSearchServer*

• InformationManagerServer*

• AnalyticsServer*

• AnswerFlowEditorServer*

• AnswerFlowRuntimeUIServer *

   *or the names specified during the setting of the managed server values for each product.

3 Select Delete.

4 When the confirmation screen appears, click Yes.

MACHINES

1 Navigate to Environment > Machines.

2 Select the checkboxes for any machines you created while installing Oracle Knowledge products and 
now wish to delete.

3 Select Delete.
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4 When the confirmation screen appears, click Yes.

DEPLOYMENTS

1 Navigate to Deployments.

2 Select the checkboxes for the following: 

• Intelligent Search Applications*

• Information Manager Applications*

• Analytics Applications*

• AnswerFlowEditor*

• SampleUI*

   *or the appropriate name for your applications, if you have any deployed.

3 Select Delete.

4 When the confirmation screen appears, click Yes.

Complete the Removal Process

When the managed servers, machines, and deployments have been removed, click the Activate Changes 
button.
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